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CHAPTER 1: INTRODUCING TIMBUKTU PRO

Welcome to Timbuktu Pro for Windows™!

Timbuktu Pro for Windows gives you total access to your network. Computers
across the country and around the world—Windows and Macintosh—are now as
accessible to you as the computer sitting on your desk! You can use Timbuktu Pro
to control and observe other computers, send instant messages, transfer files,
and text-chat or speak with remote users in real time. And Timbuktu Pro for Win-
dows offers direct modem-to-modem connections between computers—with no
network connection required.

TIMBUKTU PRO SERVICES

The simple but powerful Timbuktu Pro interface provides you with the following
services:

Send lets you send messages with attached files and folders to a remote
computer.

Exchange lets you access the hard drive of a remote Timbuktu Pro computer—
even a Macintosh. You can copy and move files and folders between comput-
ers and delete files from either computer.

Control lets you control a remote computer from your own desktop.

Observe lets you observe a remote computer without controlling it.

Notify alerts you when a remote Timbuktu Pro computer becomes active.
Chat lets you carry on a keyboard conversation with a remote user.

Intercom lets you speak directly to a remote user through your computer’s
audio hardware.

Invite allows you to invite other users to access your computer using the Tim-
buktu Pro service you specify.

17
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CONNECTING WITH TIMBUKTU PRO

When you’re at the office, Timbuktu Pro runs over your company’s local area net-
work (LAN) for easy conferencing and information sharing. When you’re home or
traveling, you can log on to a remote access server and use Timbuktu Pro to take
direct control of your office computer. You can even use your modem to dial di-
rectly into the modem of another computer, with no network connection required.

Once you connect to a remote computer with Timbuktu Pro, you can run “LAN-
locked” software at its normal speed, dramatically decreasing over-the-phone de-
lay of applications such as relational databases and electronic mail. Timbuktu Pro
gives you full access to remote resources, but transfers only screen, keyboard,
and mouse information—you don’t have to move large amounts of data over slow
telephone links.

Timbuktu Pro uses a flexible and comprehensive security scheme. You can spec-
ify many different levels of access for remote connections to your computer: you
may allow all guests access to some services, while limiting other services to spe-
cific users that you define, and admitting still other users and granting services
on a case-by-case basis. You can even prevent remote users from connecting to
your computer entirely.

How DoOES IT WORK?

Timbuktu Pro communicates with other Timbuktu Pro computers over TCP/IP
(Transmission Control Protocol/Internet Protocol) networks or through direct
modem-to-modem connections.

You can use Timbuktu Pro to access other computers or to provide remote access
to your own PC. Timbuktu Pro can work in both directions at once: another user
can send files to you while you are controlling or observing a third computer.

Timbuktu Pro runs in the background of your Microsoft Windows computer. Instal-
lation takes only minutes. Timbuktu Pro is non-intrusive; it doesn’t replace your
video, mouse, or keyboard drivers.

Timbuktu Pro works overyour LAN, WAN (Wide Area Network), DSL, cable, dial-up,
or ISDN (Integrated Services Digital Network) lines. You can use Timbuktu Pro for
file transfer, remote control, and message exchange with other Timbuktu Pro com-
puters anywhere in the world.
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WHAT TimBUKTU PRO CAN DO FOR YOU

With Timbuktu Pro, you can

e Support end users from your desk. Save technical support time and money
when you use remote control to solve user problems. Take control of a remote
user's computer and solve the problem without even leaving your chair.

e Train employees and customers alike for a fraction of the usual time and cost.
Demonstrate the latest applications, databases, and specialized products
while a remote user watches. Then observe and help as the user practices.
Provide individual attention for all remote trainees, and save the time and ex-
pense of travel.

e Work remotely from wherever you are. Harness the power of remote control to
share information, transfer files, read electronic mail, access databases, and
send quick messages across your network. You’ll discover many ways to work
easier and smarter.

®  Run “LAN-locked” applications easily. End the frustration of slow run-time
over remote links for network applications such as databases. Because the
applications run only on the remote computer, and not across telephone
lines, you’ll speed up processing time dramatically.

e Collaborate with remote colleagues in real time. Share screens, documents,
and information. Work with others anywhere, and confer with your colleagues
using audio- or text-based conferencing.

e Protect your network resources. You can grant varying levels of Timbuktu Pro
access to different users. Registered User and Windows NT User accounts and
passwords can protect any combination of Timbuktu Pro services.

WHO CAN CONNECT TO YOUR TIMBUKTU PRO COMPUTER?

The first and most important answer is “No one—without your permission!” But
once you have set up your security options, anyone who meets your connection
criteria may connect.

If your computer is connected to a company network that is protected by a fire-
wall, your Timbuktu Pro computer may only be accessible to users from your local
network. However, firewalls can be configured to admit Timbuktu Pro traffic.
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TIMBUKTU PRO FEATURES

Timbuktu Pro’s rich feature set lets you use it more efficiently and securely than
ever before. Remote control capability; Dial Direct, LDAP, and Internet Locator fea-
tures; enhanced security: Timbuktu Pro is packed with features to make your net-
work work for you.

NEW IN VERSION 7

Timbuktu Pro version 7 takes full advantage of the Internet as well as the most re-
cent improvements and features available in the Windows OS. You will benefit
from the latest file sharing and collaboration service refinements. Plus, Timbuktu
Pro version 7 includes a number of new features to make it easier than ever for
you manage your files across the network and collaborate with remote users.

INVITE SERVICE

Timbuktu Pro version 7 includes a new service, /nvite. This service allows you to
invite other users to access your computer using the Timbuktu Pro service you
specify. For details, see “Invite: Inviting a Remote User to Access your Computer”
on page 68.

TIMBUKTU PRO SCANNER

The new Timbuktu Pro Scanner helps you find and connect to remote computers,
even when you don't know their IP addresses, by browsing your local network for
active Timbuktu Pro computers. You may even connect to the desired computer
without leaving the Timbuktu Pro Scanner. For details, see “Scanning Your Net-
work for Timbuktu Pro Computers” on page 46.

REMOTE CONTROL CAPTURE FRAME

The Observe/Control tab in the Preferences dialog box now includes a new op-
tion, Use Capture Frame. When you enable the Use Capture Frame option, the
Capture Frame will open on your desktop when a remote computer establishes a
Control or Observe connection to your computer. During the screen-sharing ses-
sion, only the portion of your desktop that appears in the Capture Frame is
displayed in the screen-sharing window on the remote computer. For details, see
“Using the Capture Frame” on page 61.
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SHRINK TO FIT

The system menu in the screen-sharing window now includes a new option:
Shrink to Fit. When this option is selected, the view of the remote desktop in the
screen-sharing window is automatically reduced so that it fits entirely within the
screen-sharing window. If you resize the screen-sharing window, the view of the
remote desktop is also resized.

ADDITIONAL SCREEN-SHARING WINDOW ENHANCEMENTS

In addition to the Remote Control Capture Frame and Shrink to Fit features, the
screen-sharing window includes several additional enhancements:

e The screen-sharing window now supports a mouse wheel and extra mouse
buttons.

¢ When you control a remote computer, its CAPS LOCK, NUM LOCK, and SCROLL
LOCK states are set to match your computer’s settings.

e Keyboard mapping is now performed logically, rather than physically. For ex-
ample, if the host computer uses a Qwerty keyboard and the guest computer
uses a Dvorak keyboard, pressing the Y key on the guest computer will have
the same effect as pressing the Y key on the host computer.

TIMBUKTU PRO SERVICES

Each of Timbuktu Pro’s services allow you to interact with remote computers in a
different way; together, they help you make the most of your network. For details
about the various Timbuktu Pro services, see “Chapter 5: The Timbuktu Pro Ser-
vices.”

REMOTE CONTROL AND SCREEN-SHARING

Control a remote computer anywhere on your network using Timbuktu Pro’s
IntelliScreen™technology. Timbuktu Pro’s Control and Observe services provide a
powerful tool for user support, training, and collaboration. Timbuktu Pro automat-
ically adapts to any video mode. The AutoScroll™ feature offers automatic pan-
ning as you move your pointer on the remote desktop. Thus, you can always view
the entire screen of the remote computer, even when monitor resolutions are
different.
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SEND—SENDING MESSAGES

Use the Send service to send FlashNotes™—instant messages that pop up on the
recipient’s desktop—to other Timbuktu Pro users. You can attach files and folders
to your FlashNotes, transferring them across your network quickly and easily.

EXCHANGE—FILE TRANSFER

The Exchange makes transferring files between computers easy. Use it to copy,
move, and delete files across the network—even on Macintosh computers! The
Exchange window makes the remote computer’s file system as accessible as your
own,

NOTIFY, CHAT, INTERCOM, AND INVITE

Communicating with other Timbuktu Pro users is more convenient than ever with
Timbuktu Pro’s Notify, Chat, and Intercom services. Notify alerts you when a re-
mote computer becomes active. Chat allows you to have a keyboard “conversa-
tion” with another user. Intercom lets you have a voice conversation using your
microphone and speakers—no telephone required. Invite allows you to invite
other users to access your computer using the Timbuktu Pro service you specify.

OTHER TIMBUKTU PRO FEATURES

In addition to the enhancements in Timbuktu Pro version 7 and the Timbuktu Pro
services, all your favorite tools and features from previous versions are still avail-
able.

COMPREHENSIVE MULTI-LEVEL SECURITY

You can restrict remote access to your computer to as few or as many remote us-
ers as you wish. Anyone can access the services you provide to Guest Users. You
can define any number of Registered Users and Windows NT Users, who will have
password-protected access to the specific combination of user access privileges
you specify. And if you wish to grant one-time-only access to other Timbuktu Pro
services, remote users can ask for permission to use services you have not as-
signed. If you choose OK, they’re connected. If you don’t, they aren’t. For tightest
security, you can even require Registered Users and Windows NT Users to ask for
permission after they’re authenticated.
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SHORTCUT MENU

The Timbuktu Pro shortcut menu lets you quickly open Timbuktu Pro and monitor
incoming connections. When a remote user connects to your computer, the Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating that a service is in use. For a list of Timbuktu Pro service icons, see “lcon
Legend” on page 94.

CROSS-PLATFORM CONNECTIONS

Timbuktu Pro offers remote control and file transfer between Windows and Macin-
tosh computers. From a PC or a Macintosh, you can remotely control a computer
of either type as if you were seated in front of it. Timbuktu Pro also provides
cross-platform file transfer with a convenient, one-step procedure. You can even
customize your cross-platform file-mapping settings so that Windows file exten-
sions and Macintosh Type/Creator settings are applied automatically.

DiIAL DIRECT CONNECTIONS

Timbuktu Pro’s Dial Direct feature allows you to use your modem to connect di-
rectly to the modem of another Timbuktu Pro computer. No Internet connection is
required. You can use any of the Timbuktu Pro services, except Intercom.

NETOPIA’S INTERNET LOCATOR SERVER

The Internet Locator feature allows you to connect to other Timbuktu Pro users by
specifying their email addresses instead of their IP addresses. When you enter
an email address on the TCP/IP tab in the main Timbuktu Pro window, Timbuktu
automatically queries Netopia’s Internet Locator server, resolves the correct IP
address, and connects to the remote computer.

LDAP SEARCHES

Timbuktu Pro’s LDAP (Lightweight Directory Access Protocol) support allows you
to easily find and connect to other computers running Timbuktu Pro, without
knowing their IP addresses. Instead of entering a remote user’s IP address, you
can use the LDAP tab to search for other LDAP-enabled Timbuktu Pro users by
their user information. Search strings include computer name, IP address, user
name, email address, location, and comment. You can also store your own infor-
mation to enable other users to find you. User information is stored on Netopia’s
public LDAP server.
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TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to acti-
vate a Timbuktu Pro service to a remote computer from a desktop icon. To quickly
create a desktop shortcut, right-click anywhere on your desktop. From the short-
cut menu, choose New » Timbuktu Pro Connection Document.

Once you’ve created a Connection Document, right-click it to display a shortcut
menu. The menu allows you to rename your Connection Document, change its
properties, or delete it. See “Timbuktu Pro Connection Documents” on page 52
for details.

NETWORK NEIGHBORHOOD/MY NETWORK PLACES

Timbuktu Pro’s Network Neighborhood/My Network Places integration gives you
immediate access to remote computers without opening the main Timbuktu Pro
window. In the Network display, right-click on any computer. From the shortcut
menu, choose Timbuktu Pro » Any Service. You can launch any Timbuktu Pro ser-
vice, as long as the remote computeris running Timbuktu Pro and uses the TCP/IP
protocol.

ADDRESS BOOKS

Use Timbuktu Pro’s address books to help you organize the IP addresses of the
remote computers you connect to frequently. An address book is a collection of
Timbuktu Pro addresses. They save you time because you don’t have to enter an
IP address every time you make a connection—simply select a computer from the
list.

RECENT CONNECTIONS

The Recent Connections tab contains a list of computers to which you’ve recently
established connections. The default service (the service that was used during
the previous remote connection) is also saved. Simply double-click an address to
reconnect.

ACTIVITY LoG

Timbuktu Pro keeps a list of all connections made to your computer. The activity
log shows each user’s Timbuktu Pro computer name and IP address, records
when the user connected, and specifies which services the user accessed. For file
transfers using the Send and Exchange services, the file name and the local direc-
tory involved in the transfer are logged on both computers. For Exchange file
transfers, the guest computer also logs the remote directory.
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You can display the activity log or save it to a text file for printing.

On Windows NT-based computers, Timbuktu Pro also logs guest and host service
events to the Application Event Log. Whetheryou use the Application Event Log or
not, the standard Timbuktu Pro activity log is still created.

SYSTEM REQUIREMENTS FOR TIMBUKTU PRO

To run Timbuktu Pro for Windows, your computer must meet the following hard-
ware, software, and compatibility requirements.

MINIMUM HARDWARE REQUIREMENTS

Timbuktu Pro requires 20MB of free disk space for installation. 5oMB are required
for the network installation process.

If you wish to make a Dial Direct connection using Timbuktu Pro, you will need a
56 Kbps modem.

MINIMUM SOFTWARE REQUIREMENTS

*  Microsoft Windows 98, Windows NT 4.0 (Service Pack 6 or later), Windows
2000, Windows ME, Windows XP, or Windows 2003 Server.

e TCP/IP networking software that is installed and properly configured.

e ForDial Direct connections, modem software that is installed and properly
configured. Dial Direct connections use the TCP/IP protocol, so network soft-
ware is still required.

COMPATIBILITY

e ForTCP/IP connections, the remote computer must be on a TCP/IP network
and be running Timbuktu Pro for Windows version 4.5 or later, or Timbuktu
Pro for Macintosh 5.2.4 or later.

e For Dial Direct connections, the remote computer must have a 56 Kbps
modem.

Older versions of Timbuktu Pro are not officially supported with Timbuktu Pro ver-
sion 7.
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CHAPTER 2: INSTALLING TIMBUKTU PRO FOR
WINDOWS

This chapter will guide you as you install or un-install Timbuktu Pro on a local
computer.

To use the Network Installer or install Timbuktu Pro with Active Directory Group
Policies, see the documentation on the Timbuktu Pro Enterprise Resource Center.
The “Using Timbuktu Pro with Active Directory” document is also available on
your Timbuktu Pro CD.

BEFORE INSTALLING TIMBUKTU PRO FOR WINDOWS

Before you install Timbuktu Pro, you must prepare your computer for the
installation.

To PREPARE YOUR COMPUTER FOR TIMBUKTU PRO INSTALLATION

1. Make sure that TCP/IP software is installed and running on your computer, or
that you have a modem set up and functioning correctly.

2. Uninstall any other remote control software and restart your computer.

3. Disable or shut down any antivirus software installed on your computer.
Active antivirus programs may cause problems during the installation
process.

4. Install Timbuktu Pro.

Note: Users of computers with Windows NT-based operating systems must be
logged on to the local computer with Administrator or Domain Administrator
privileges to install Timbuktu Pro.

It is extremely important to uninstall any other remote control software and re-
start your computer before you install Timbuktu Pro. If you install Timbuktu Pro
over other remote control software, or if you do not reboot after uninstalling other
software, Timbuktu Pro may not be completely installed.

[17
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INSTALLING TIMBUKTU PRO FOR WINDOWS

You will install Timbuktu Pro from the CD-ROM supplied in your Timbuktu Pro
package or from the Th2ProWin.exe self-extracting archive file you downloaded
from Netopia’s Web site.

To INSTALL TIMBUKTU PRO
1. Uninstall any other remote control software, restart your computer, and close
all open applications, including antivirus software.

2. Ifyou have a Timbuktu Pro CD, insert it into your CD-ROM drive. Open the CD
and double-click the Setup.exe file to launch the Timbuktu Pro Installer.

If you downloaded the Th2ProWin.exe file, double-click it. You can specify

the folder where the Timbuktu Pro installation files will be extracted. If you
leave the When Done Unzipping option selected, installation will proceed

automatically after the file extraction is complete.

3. The Welcome dialog box appears.

welcome [ ]

‘Welcome ta the Timbuktu Pro Setup program.  This
ti m b Uktu pro program will install Timbulbu Pro on your computer.
e
. o

It iz strongly recommended that wou exit all Windows programs
before running this Setup program.

Click Cancel to quit Setup and then close any programs you have
wnning. Click Mext to continue with the S etup program.

It iz also recommended that pou review the release notes before
inztalling this praduct. Click Release Mates to view it.

WARMIMG: This program iz protected by copyright law and
intemational treaties

Unauthorized reproduction or distribution of this program, or any
. portion of it, may result in severe civil and criminal penalties, and
netvp|a_ will be prozecuted to the maximum extent possible under law.

< Back | Mest » | Cancel |

If you wish to view the Release Notes before you install Timbuktu Pro, click
the Release Notes button. The Release Notes may contain important installa-
tion information that was not available at the time this document was
printed, and it may inform you of new or modified features in the latest ver-
sion of Timbuktu Pro.
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After you view the Release Notes, choose Next. The Software License Agree-
ment dialog box appears. After you have read the license agreement, click
Yes to accept it.

The Checking for Installed Components dialog box appears. When you click
Next, the installer will ensure that no potential hardware or software conflicts
exist.

When the check is complete, the Select Destination Directory dialog box
appears.

Select Destination Directory | ]

. Setup will install to the fallawing directany
timbuktu pro
. E—

If you click Mext', the installation will proceed in the
specified directary.

To cancel the installation, please click the Cancel buttan.

Drestination Directory
’7 c:\Program FileshTimbuktu Pro

Available disk space E52245 K,
nEthla‘ Required disk space: 15000 K.
< Back | Mest » | LCancel |

By default, Timbuktu Pro is installed in the Program Files » Timbuktu Pro
directory on the same drive where Windows is installed. If you wish to install
it elsewhere, click the Browse button and navigate to the desired location.

Choose Next to proceed to the Ready to Install dialog box, and click Next
again to begin installation. When installation is complete, you will receive a
message indicating that installation was successful. Timbuktu Pro starts
automatically.

If desired, restart your computer. You can run Timbuktu Pro immediately, but
restarting your computer will improve Timbuktu Pro’s performance.
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REMOVING TIMBUKTU PRO FROM YOUR COMPUTER

Should you wish to remove Timbuktu Pro from your computer, it is important to
follow the correct uninstallation procedure.

To REMOVE TIMBUKTU PRO FROM YOUR COMPUTER

1.

Shut down Timbuktu Pro completely. (Click the File menu and choose Exit
and Shut Down Timbuktu Pro.)

From the Windows Start menu, choose Programs » Timbuktu Pro » Timbuktu
Pro Uninstaller.

The Timbuktu Pro Uninstaller dialog box appears. You’re asked to confirm
your intention to remove Timbuktu Pro.
Timbuktu Pro Uninstaller [ %]

Do you want to uninstall Timbuktu Pro ? Thizs will delete all files in pour Timbuktu Pro
directory.

ok [

Note: If you confirm the uninstallation, all files and folders in the Timbuktu
Pro installation folder will be deleted even if they are not part of Timbuktu Pro.
Make sure the folder contains no files that you wish to save.

Click OK to uninstall Timbuktu Pro. All the contents of the Timbuktu Pro
installation folder and its subdirectories are deleted.
Restart your computer.

Note: When uninstallation is complete, a dialog box allows you to choose to
restart your computer immediately or later. You must restart your computer to
complete uninstallation.



CHAPTER 3: SETTING UP TIMBUKTU PRO

Once you have installed Timbuktu Pro, you can review and change your configura-
tion settings. This chapter describes how to start and exit Timbuktu Pro and how
to set Timbuktu Pro configuration preferences.

TIMBUKTU PRO STARTUP OPTIONS

By default, Timbuktu Pro will start automatically when you start Windows. Its icon
is placed in the system tray on the taskbar. To open the main Timbuktu Pro win-
dow, double-click the Timbuktu Pro icon. Or right-click the icon to display the
shortcut menu, and choose Open.

il Slalll 5] Contral Parel | ﬁ Metapia Welcomesl Iy Computer | é 309 PM

Note: If you are running Windows XP, the full Timbuktu Pro application will not
start automatically. The MiniTB2 application is launched instead. MiniTB2 will
accept incoming Timbuktu Pro connections, but to establish outgoing connec-
tions, you must open the main Timbuktu Pro window by starting the full Timbuktu
Pro application. See the following section, “Starting Timbuktu Pro Manually.”

STARTING TIMBUKTU PRO MANUALLY

If Timbuktu Pro is not launched automatically, or if you shut it down, you can man-
ually start Timbuktu Pro at any time. From the Windows Start menu, choose Pro-
grams » Timbuktu Pro » Timbuktu Pro. The main Timbuktu Pro window opens.

You can configure Timbuktu Pro startup preferences using the General tab in the
Preferences dialog box (see page 23).

[ 21
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EXITING AND SHUTTING DOWN TIMBUKTU PRO

When you close Timbuktu Pro, you may simply exit the program, or exit and shut it
down. When you exit Timbuktu Pro without shutting it down, Timbuktu Pro contin-
ues to run in the background. Exiting without shutting down gives remote users
the ability to connect to your computer even though you aren’t making any outgo-
ing connections.

When you exit and shut down Timbuktu Pro, Timbuktu Pro no longer runs in the
background and users can no longer connect to your Timbuktu Pro computer.

The Timbuktu Pro File menu thus has two exit options: Exit and Exit and Shut
Down Timbuktu Pro. These are explained below.

Dpen Address Book...
Close Address Book

BrEEE RS, Ll ERtEr
Delete =]

Exit and Shut Down Timbuktu Pro Alt+Ctrl+F4
Exit Alt+F4

EXIT TIMBUKTU PRO OPTION

To exit without shutting down Timbuktu Pro, click the File menu and choose Exit.
Or click the Close box in the upper-right corner of the main Timbuktu Pro window.
Exiting Timbuktu Pro closes the main Timbuktu Pro window. The Timbuktu Pro
icon appears in the system tray on the Windows taskbar to remind you that Tim-
buktu Pro can still accept incoming connections. Double-click the taskbar icon to
reopen the main Timbuktu Pro window.

EXIT AND SHUT DOWN TIMBUKTU PRO OPTION

To shut Timbuktu Pro down completely, click the File menu and choose Exit and
Shut Down Timbuktu Pro. If any connections are active, they will be shut down.
Remote users will not be able to initiate new connections with your computer.

You can also shut down Timbuktu Pro by right-clicking the Timbuktu Pro icon in
the system tray on the taskbar. From the shortcut menu, choose Exit and Shut
Down Timbuktu Pro.
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CUSTOMIZING YOUR TIMBUKTU PRO PREFERENCES

The Preferences dialog box lets you specify certain configuration options for Tim-
buktu Pro. To open the Preferences dialog box, click the Setup menu and choose
Preferences. The six tabs in the Preferences dialog box are as follows:

General—Timbuktu Pro general and startup preferences. See page 23.
Observe/Control—Screen-sharing window preferences. See page 25.
Send—Send service preferences. See page 29.

Notify—Notify service preferences. See page 31.

Master Password—An optional password restricting access to Timbuktu Pro’s
Preferences, Security, and LDAP Options dialog boxes. See page 32.

Dial Direct—Dial Direct preferences. See page 33.

Note: LDAP preferences are set in the LDAP Options dialog box. See “Setting LDAP
Options” on page 35.

The following sections describe each of these tabs.

GENERAL PREFERENCES

The General tab lets you specify whether Timbuktu Pro will start when you start
Windows. You can also enter information for use by the Internet Locator Server.

TO CHANGE YOUR GENERAL PREFERENCES

1.
2.

From the Setup menu, choose Preferences.
In the Preferences dialog box, click the General tab.

Preferences | %]

General | Dbserve.-"tonlroll Send I Maotify I Master Passwordl DiaIDirectI

LComputer Mame IEomet

¥ Start Timbuktu Pra az a service

Internet Locatar
¥ Intemet Locator enabled

Email &ddiess  |haleboppi@timbukiu. com

QK I Cancel Apply Help
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3. Specify the Timbuktu Pro Computer Name. The name of your computer iden-
tifies your computer to other Timbuktu Pro computers. It does not need to be
the same as your Windows networking computer name.

4. Select Start Timbuktu Pro as a Service if you want the Timbuktu Pro applica-
tion to be started as a service. For more information, see the following sec-
tion, “Launching Timbuktu Pro as a Service.”

By default, Timbuktu Pro is started as a service, which makes it available at
the network logon prompt.

5. Select Internet Locator Enabled and enter your email address if you want to
use the Internet Locator service on your computer. For information about the
Internet Locator server, see “The Internet Locator” on page 24.

6. Click OKto save your changes and close the Preferences dialog box.

LAUNCHING TIMBUKTU PRO AS A SERVICE

By default, the Timbuktu Pro application is launched as a service. It is started au-
tomatically as soon as Windows has loaded on your computer, and before Win-
dows requires you to log in. This lets you control your computer remotely and enter
your Windows user name and password, just as if you were sitting at the com-
puter, or use services such as Exchange without logging in to Windows at all.

If you prevent Timbuktu Pro from starting automatically, you must start it manually.
See “Starting Timbuktu Pro Manually” on page 21. Note that if Timbuktu Pro does
not start automatically, you will not be able to control your computer remotely af-
ter a restart.

THE INTERNET LOCATOR

Netopia’s Internet Locator server allows you to connect to other Timbuktu Pro
computers using an email address instead of an IP address. This is particularly
helpful when a remote computer is connected to an Internet Service Provider (ISP)
that assigns dynamic IP addresses. You can enter the remote user’s email ad-
dress on the TCP/IP tab in the main Timbuktu Pro window and then select a ser-
vice. The Internet Locator server translates the email address to the correct IP
address and makes the connection using the service you selected.

Netopia maintains an Internet Locator server for public use. (Its DNS name is
findme.netopia.com.) When the Internet Locator service is enabled on your com-
puter and you launch Timbuktu Pro while connected to the Internet, your email
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address and the associated IP address are automatically sent to the server. Other
Timbuktu Pro users can then connect to you by entering your email address on
the TCP/IP tab.

OBSERVE/CONTROL PREFERENCES

Timbuktu Pro Control and Observe session take place in a screen-sharing
window, which displays the remote computer’s desktop on your screen. The
Observe/Control tab in the Preferences dialog box lets you specify whether the
screen-sharing window will scroll manually or automatically when you control or
observe a remote computer. You can also specify options that may improve
screen-sharing performance and security when remote users use the Control or
Observe service with your computer.

Timbuktu Pro also supports secure screen blanking. Secure screen blanking is a
Timbuktu Pro security feature that prevents unauthorized viewing of your com-
puter’s screen while it is being controlled by a remote user. For more information,
see “Secure Screen Blanking” on page 27.

To CHANGE YOUR OBSERVE/ CONTROL PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Observe/Control tab.

zl

General  Observe/Control |Send I M atify I Paster F'asswordl DiaIDirectI

— Obzerve/Control winda:
f+ Automatically scroll the window

= Manually scrall the window

—when uzers Observe/Contral my screen
[ Display desktop wallpaper
IV Use capture frame
¥ Use accelerated remote contral
[ Elark my zcreen when users contral my computer

™ Lock my computer when ugers end contral sessions

Ok, I Cancel Al Help
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3.

In the Observe/Control Window area

e Select Automatically Scroll the Window to scroll a screen-sharing window
automatically when your mouse pointer approaches the edge of the win-
dow or when the pointer on the remote desktop moves out of view.

e Select Manually Scroll the Window to cancel the automatic scrolling
described above. You can scroll the window manually by clicking on the
scroll bars at the edge of the window.

Note: Because there are no scroll bars when a screen-sharing window is
maximized, a maximized window always scrolls automatically.

In the When Users Observe/Control My Screen area, clear the Display Desk-
top Wallpaper option to remove the Windows wallpaper from your desktop
when a remote user is controlling or observing your computer. This increases
the screen-sharing performance of Timbuktu Pro. The wallpaper reappears
when the remote control session ends.

Select the Use Capture Frame option to restrict the view of your desktop
when a remote computer establishes a Control or Observe connection to your
computer. During the screen-sharing session, only the portion of your desk-
top that appears in the Capture Frame is displayed in the screen-sharing win-
dow on the remote computer. For details, see the following section,
“Enabling the Remote Control Capture Frame.”

Select Use Accelerated Remote Control to use the video-driver-based remote
control component, which increases Timbuktu Pro’s screen-sharing perfor-
mance. Clear this checkbox to use the Universal Remote Control Adapter,
which makes Timbuktu Pro more compatible with different video cards and
video settings.

The Universal Remote Control Adapter also supports systems with multiple
monitors. If you have a multiple-monitor setup, disable the Use Accelerated
Remote Control option.

Select Blank My Screen when Users Control My Computer to activate secure
screen blanking. Secure screen blanking is a Timbuktu Pro security feature
that prevents unauthorized viewing of a computer’s screen while it is being
controlled by a remote user. See “Secure Screen Blanking” on page 27.

Note: This option is not available when you enable the Use Capture Frame
option.

Select Lock My Computer When Users End Control Sessions to lock your
Windows NT-based computer when an incoming Control session is complete.
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When the remote user finishes controlling your computer and disconnects,
your computer is locked automatically to ensure security (as if you had
pressed CTRL+ALT+DEL and chosen Lock Workstation).

Windows 98 and Windows ME do not support secure logons. Therefore,
while Timbuktu Pro will blank the screen of your computer while it is being
controlled, it is unable to secure the computer when the Control session
ends.

Note: This option is not available when you enable the Use Capture Frame
option.

9. Click OKto save your changes and close the Preferences dialog box.

ENABLING THE REMOTE CONTROL CAPTURE FRAME

When you enable the Use Capture Frame option on the Observe/Control tab in the
Preferences dialog box, the Capture Frame will open on your desktop when a re-
mote computer establishes a Control or Observe connection to your computer.

The Capture Frame restricts the remote user’s view of your desktop. During the
screen-sharing session, only the portion of your desktop that appears in the Cap-
ture Frame is displayed in the screen-sharing window on the remote computer. In
addition, the screen-sharing session will not begin until you click the Play button
in the upper-left corner of the Capture Frame.

Note: Do not enable the Use Capture Frame option if anyone will need to use the
Control or Observe service to access your computer when you are not present.
Because you must click the Play button to allow the screen-sharing session to
proceed, you must be physically present at the host computer.

For additional information about using the Capture Frame, see “Using the Capture
Frame” on page 61.

SECURE SCREEN BLANKING

Secure screen blanking is a Timbuktu Pro security feature that prevents unautho-
rized access to your computer while it is being controlled by a remote user. When
secure screen blanking is active, no one will be able to see what is happening on
the computer’s desktop. (They may be able to see the cursor move and hear any
audio the computer generates.)

For example, if the Help desk is installing new software or doing extensive
configuration of your system, you may need to leave your computer before the
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installation is complete. When the remote user finishes with your computer, it will
be secure until you return. When you’re off-site, you can remotely control your
own computer without compromising its security.

Secure screen blanking works differently in different situations: whether or not
you are logged in to your computer, and—if you’re logged in—whether or not your
computer is locked before the remote user takes control.

You should always protect the security of your computer by using a password-pro-
tected screen saver. When you are away from your computer, the locking mecha-
nism will help to ensure your security.

WHEN YOU’RE WORKING AT YOUR COMPUTER

Windows NT
Windows 2000
Windows XP
Windows 2003

Windows 98
Windows ME

If you are working at your computer and a remote user controls it
(for example, the Help Desk takes control to troubleshoot a prob-
lem you’re having), the screen will not blank. You will be able to
watch the remote user’s actions and, if necessary, disconnect the
user from your computer.

If your computer is controlled by a remote user, the screen will
blank, even if you’re actively using the computer. You will not be
able to activate your monitor until the remote user disconnects.
When the remote user ends the control session, the screen is
restored.

WHEN YOUR SCREEN IS LOCKED

Windows NT

Windows 2000
Windows XP
Windows 2003

If your computer is locked and a remote user controls it, the Work-
station Locked dialog box will remain on your screen. It will not be
apparent that your computer is being controlled, except the cursor
may move. However, you will not be able to unlock your computer
locally until the remote user disconnects. If you press
CTRL+ALT+DEL, the Windows NT Security dialog box will appear in
the remote user’s Control window, but your screen will remain
unchanged.

If your computer is locked and a remote user controls it, the screen
will blank. You will not be able to activate your monitor until the
remote user disconnects. When the remote user ends the control
session, the Workstation Locked dialog box will reappear.
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Windows 98 If your computer is locked using a password-protected screen saver

Windows ME and a remote user controls your computer, the screen will blank.
You will not be able to activate your monitor until the remote user
disconnects. When the remote user ends the control session, the
screen will appear as the remote user left it—the screen saver will
not be displayed. The computer will be secure once the password-
protected screen saver activates.

WHEN YOU HAVEN’T LOGGED IN

Windows NT If you have not logged in to your computer and a remote user con-
trols it, the Windows Logon Information dialog box will remain on
your screen. It will not be apparent that your computer is being con-
trolled, except the cursor may move. However, you will not be able
to log in to your computer locally until the remote user logs out of
Windows and disconnects. If you press CTRL+ALT+DEL, the Win-
dows NT Security dialog box will appear in the remote user’s Con-
trol window, but your screen will remain unchanged.

Windows 2000 If you have not logged in to your computer and a remote user con-

Windows XP trols it, the screen will blank. You will not be able to activate your

Windows 2003 monitor until the remote user disconnects. When the remote user
ends the control session, the Logon Information dialog box will
reappear.

Windows 98 If the Log On screen appears on your computer and a remote user

Windows ME controls it, the screen will blank. (Because Windows 98 and Win-

dows ME do not support secure logons, the remote user may
choose to log on or to bypass the Log On screen.) When the remote
user ends the control session, the screen will appear as the remote
user left it—the screen saver will not be displayed. The computer
will be secure once the password-protected screen saver activates.

SEND PREFERENCES

The Send service lets you send messages called FlashNotes to other Timbuktu Pro
computers. You can customize Timbuktu Pro to notify you of an incoming
FlashNote by displaying the FlashNote in a full-sized window or by displaying the
FlashNote as a minimized icon on the taskbar. In addition, you can designate how
much of your disk space should be protected from temporary storage of
FlashNotes and their enclosures.
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TO CHANGE YOUR SEND PREFERENCES

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Send tab.
Generall Observe/Contral - Send |N0tify I Master Passwordl Dia\DirectI

—wh

= Show az a minimized icon

— Digk Usage
Megabytes of disk space protected from use by FlashMotes: |1 1]
Save files inside this folder.

CAPROGRAM FILESNTIMBUETU PRO

Browsze... |
0k I Cancel | Lol | Help |

3. Inthe When a Note Arrives on My Computer area, select Show in a Full-Sized
Window to see newly received FlashNotes and attached enclosures
immediately. Select Show as a Minimized Icon to display the FlashNote as an
icon in the taskbar. The icon indicates that a message has arrived.

4. Inthe Disk Usage area

e To limit the amount of disk space used by files sent by the Send service,
enter the desired number of megabytes in the Megabytes of Disk Space
Protected from Use by FlashNotes field. This prevents users from entirely
filling up your disk with FlashNotes and enclosures.

e Files transferred using the Send function are stored in a files received
folder. Specify the location of the files received folder on your computer
in the Save Files Inside this Folder field.

If someone attempts to send files or folders that would require more disk
space on your computer than is available, Timbuktu Pro notifies them that
there isn’t enough disk space to carry out the file transfer.

This option does not restrict file transfer using the Exchange service.
5. Click OKto save your changes and close the Preferences dialog box.
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NOTIFY PREFERENCES

The Notify service lets remote users request notification when your computer be-
comes active. You can specify that Timbuktu Pro prompt you before responding to
a notification request, or you can configure Timbuktu Pro to respond to notifica-
tion requests automatically, based on your mouse and keyboard activity.

To CHANGE YOUR NOTIFY PREFERENCES
1. From the Setup menu, choose Preferences.

2. Inthe Preferences dialog box, click the Notify tab.

General I Obzerve/Control I Send  Matify | Master Password I Dial Direct I

If someone asks to be notified when | become active
’76’ EBrompt me for an answer

© Answer automatically [based on mouse and keyboard activity)

‘wihen someone asks to be notified, tell them...
™ when | last used my compuiter.
vV Message:

\working at home on ‘wWednesday ] d

[
QK I Cancel | Apply | Help |

3. Inthe /fSomeone Asks to be Notified when | Become Active area

e Select Prompt Me for an Answer if you do not want Timbuktu Pro to auto-
matically notify users that you have become active. Timbuktu will indi-
cate which user has requested notification, and you can then choose to
notify or not to notify the user that you are available at your computer.

e Select Answer Automatically if it is OK for all users to whom you’ve
granted the Notify service to know when your computer has become
active (based on keyboard and mouse activity). Whenever a remote user
asks for notification, Timbuktu Pro will notify that user that you have
become active without telling you who is asking for notification.
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4. Inthe When Someone Asks to be Notified, Tell Them area

e Select When [ Last Used my Computer to display this information to the
remote user. The user will be told the date and time when you last used
your mouse or keyboard.

Note: If you selected Prompt Me for an Answer in step 3, and you choose
not to notify a remote user that your computer has become active, the
date and time of your last activity will not be updated on the remote com-
puter when you become active.

e Select Message and enter a message to be displayed when the remote
user asks for notification.

5. Click OK to save the changes and close the Preferences dialog box.

SETTING UP YOUR MASTER PASSWORD

Use a master password to protect access to those parts of Timbuktu Pro that allow
you to change Timbuktu Pro’s configuration—the Security, Preferences, and LDAP
Options dialog boxes. After you’ve created a master password, Timbuktu Pro will
ask you to type it whenever you attempt to open these dialog boxes.

If you protect your Timbuktu Pro settings with a master password, be sure you
choose a password you will remember. If you forget your master password, you
will need to uninstall and reinstall Timbuktu Pro.

To SET OR CHANGE YOUR MASTER PASSWORD

1. From the Setup menu, choose Preferences.
2. Ifyou have an existing master password, enter it when prompted.
3. Inthe Preferences dialog box, click the Master Password tab.

Preferences

Generall Dbsewe.-’Eontroll Send I Motify ~ Master Password |DiaIDirect|

Set the kaster Password

The Password and Confirm boxes must be identical or blank.

Password: I
LConfirm: I

Master Pazsword protects access to Preferences and S ecurity windows

Ok I Cancel Apply Help
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4. Type the new password in the Password box. The characters you enter are
displayed as asterisks. Passwords are case-sensitive.

5. Re-type the master password in the Confirm box.
6. Click OKto save the changes and close the Preferences dialog box.

Timbuktu Pro will not let you close the Preferences dialog box unless the
Password and Confirm fields match exactly.

REMOVING YOUR MASTER PASSWORD

If you wish to unprotect your Security, Preferences, and LDAP settings, you may re-
move your master password.

To REMOVE YOUR MASTER PASSWORD

1. From the Setup menu, choose Preferences.

2.  When prompted, enter your existing master password.

3. Inthe Preferences dialog box, click the Master Password tab.

4. Delete the text from both the Password and Confirm boxes.

5. Click OKto save your changes and close the Preferences dialog box.

DIAL DIRECT PREFERENCES

The Dial Direct tab in the Preferences dialog box lets you determine how incoming
calls are answered by your system. It also allows you to specify the modem that
will be used and how idle connections are handled.

By default, Timbuktu Pro will not answer incoming Dial Direct calls. If you wish to
accept Dial Direct connections, you must change your Dial Direct options on the
Dial Direct tab in the Preferences dialog box.

To CHANGE YOUR DIAL DIRECT OPTIONS

1. From the Setup menu, choose Preferences.
2. Inthe Preferences dialog box, click the Dial Direct tab.
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Preferences <]

Generall Dbserve.-"[lontmll Send I M otify I M aster Password  Dial Direct |

Device: IU_S_ Fobotics 56K win INT

On incoming calls:
Do not answer

* Anzwer after |1 fings

™ Disconnect call if idle for IU mifutes

QK | Cancel | Lol | Help |

3. Select the modem you wish to use from the Device drop-down list. Timbuktu
Pro will list the available modems as determined by your operating system. If
you need to set or change the properties of the selected modem, click the
Properties button. (See your modem documentation for a discussion of the
information required in the Modem Properties dialog box.)

4. Under On Incoming Calls, choose an option for answering calls to your com-
puter.

e Choose Do Not Answer to ignore all incoming calls. This is the default
option.

e Choose Answer After n Rings to answer calls automatically after the num-
ber of rings specified in the text box.

5. If you wish to automatically close an idle connection after a specific amount
of time, select the Disconnect Call checkbox and specify the number of min-
utes of inactivity after which the connection will automatically be terminated.

You may wish to automatically disconnect idle callers to allow another user
access when the current user is idle for long periods or forgets to disconnect.

6. Click OKto save your changes and close the Preferences dialog box.

DIALING PROPERTIES

To make outgoing connections, you may also need to set options—such as a dial-
ing prefix—in the Dialing Properties dialog box. You can open the Dialing Proper-
ties dialog box by clicking the Dialing Properties button on the Dial Direct tab in
the main Timbuktu Pro window. See your Windows or modem documentation for
more information about the Dialing Properties dialog box.
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SETTING LDAP OPTIONS

To use the LDAP server’s search functionality, you will need to set your prefer-
ences and user information in the LDAP Options dialog box. From the Setup
menu, choose LDAP.

LDAP Options |

General | Advanced I User's Profile I

¥ Enable LOVAP directary feature

— Server information

Server name: ldaptest. netopia.com
[T Active Directan Sereer

I=| Tikiie senver requires me telog o

Aeoount mame; I

Fagsyornd: I

Ok I Cancel | Apply |

The three tabs in the LDAP Option dialog box—General, Advanced, and User’s
Profile—allow you to enable the LDAP functionality, determine port usage, and
provide your own user information to the search tools on the server.

GENERAL TAB

Click the General tab to enable the LDAP Directory feature and specify a server.
Netopia’s public LDAP server is located at ldaptest.netopia.com.

ADVANCED TAB

Click the Advanced tab to change the default LDAP contact port number and LDAP
search base. You should not need to change the information on this tab unless
you are a system administrator. The default port number is 389, and the default
search base is o=timbuktu. This port and search information is required for suc-
cessful access to Netopia’s public LDAP server.
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USER’S PROFILE TAB

Click the User’s Profile tab to provide the user information that you want to regis-
ter with the LDAP server. The information you provide will be saved to the server,
and it will be queried when another user searches the server.

To CREATE YOUR LDAP USER PROFILE

1. From the Setup menu, choose LDAP.
2. Inthe LDAP Options dialog box, click the User’s Profile tab.

LDAP Options | ]

Generall Advanced  User's Profile |

User's Name: IAliEﬂ Scott

E-mail Address: Iarial@timbuktu.com

Location: INorth Building. 3rd Floor

Carnment: working at home Tuesday and Thursday)] ;I

|

QK I Cancel | Apply |

3. Enterthe appropriate information in each field. All information is optional.
However, complete and accurate information will make it easier for other
users to find your computer quickly.

4. Choose OKto save your changes and close the LDAP Options dialog box.

CONTROLLING ACCESS TO YOUR COMPUTER

There are several ways of maintaining security and restricting access to your com-
puter by other Timbuktu Pro computers. You may use a master password to pre-
vent anyone with direct access to your computer from changing your Timbuktu Pro
preferences. (See “Setting Up Your Master Password” on page 32.) In addition, no
remote computer can connect to your computer without your prior authorization.
There are several levels of remote access: you may assign privileges to all Guest
Users, allow remote users to ask for permission to use unassigned services, and
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create Registered Users and Windows NT Users with specific privileges. The setup
of various security measures is discussed in detail in “Chapter 6: Security.”

As an administrator, you may also use Active Directory Group Policies and Site
Keys to control security settings on your entire network. Full documentation for
Timbuktu Pro with Active Directory is available. See the “Using Timbuktu Pro with
Active Directory” PDF document on your Timbuktu Pro CD or on the Timbuktu Pro
Enterprise Resource Center. Site Key documentation is also available on the Tim-
buktu Pro Enterprise Resource Center.
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This chapter discusses how you can use the connection tabs in the main Tim-

buktu Pro window to connect to remote computers.

THE MAIN TIMBUKTU PRO WINDOW

When you open Timbuktu Pro, you will see the following window.

= Timbuktu Pro - Comet IS [=] E3
Menus ——— File Edit Wiew GSetup Services Connections Help
) : o] =
Service buttons @ I;:I'L'_"I % E | [E] @
Send Exchange Control  Observe  Motify Chat Intercom — Invite
Connection fddiess | ‘% Becert | @ TORAP % LDAF Dial
tabs LEEJ Books E’] Connectiokis E g Direct

Address Book: I personal

=

Address Book

dl’Op-dOWn list| | Semice | Computer Name | Address | Diescription
Ohserve Blaze 1234563518 Obzerve - Lillys PC (Windows 2000)
Q Send Comet 123436497 Send - AH's\Win95 Machine
k33 Cortrol Daydream 12345656 Contral - Daydream (G A LabiG4)
Q.C'D Exchange  Goothall 1253.456.34.23 Exchange - Eric's Laptop
Address List 183 Control Leprechaun 123456529 Contral - RorysMT Machine
box 1= Chat Martian 123.456.9.90 Chat - Steve Scott
E'! Motify Mionkeytioy 123.456.5.91 Motify - Adam's P333 (Monkeyhoy)
E’ Intercom Princess 1234561287 Intercom - Princess (Blue iMac)
@ Send Sport 123436.7 222 Send - Sport (NT Box)
hzerve Warrior Girl 12345611 88 Observe - Warrior Girl
[10itern(s]
Status bar |Ready | My Address : 163.176.4.43 i

= |5 x|

|
TCP/IP address of the computer
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MENUS

Use Timbuktu Pro menus to make connections, customize your Timbuktu Pro,
and define users. For more information about each menu, see “Menus in Tim-
buktu Pro” in the Timbuktu Pro online Help.

SERVICE BUTTONS

You can use service buttons as shortcuts for the Send, Exchange, Observe, Con-
trol, Notify, Chat, and Intercom options in the Services menu. All the service but-
tons remain dimmed until you have entered or selected an address in one of the
connection tabs. For details, see “Timbuktu Pro Service Toolbar” in the online
Help.

CONNECTION TABS

You can use the connection tabs to enter or select the addresses of other Tim-
buktu Pro computers you wish to connect to. To bring a tab to the front, click it.

The fact that a remote address is displayed in one of the connection tabs does not
automatically enable you to connect to that computer. Addresses remain visible
in the Address Books and Recent Connections tabs even when the computers at
those addresses are not running Timbuktu Pro or are shut down.

In addition, the user of the remote computer may not grant you permission to con-
nect using the service you have selected. To learn more about access restrictions,
see “Chapter 6: Security.”

STATUS BAR

The status bar, at the bottom of the main Timbuktu Pro window, contains two in-
formation panels. The panel on the right displays the TCP/IP address of the com-
puter. Other Timbuktu Pro users will use this address to connect to you.
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THE TiIMBUKTU PRO CONNECTION PROCESS

Before you can use any Timbuktu Pro service with a remote computer, you must
establish a connection with the computer.

As long as you have been granted access as a Guest User, Ask for Permission
User, Registered User, or Windows NT User, you can connect to any computer that
is running Timbuktu Pro over a TCP/IP network. If you have a modem, you may
also make a direct modem-to-modem connection—with no network required.

SELECTING A REMOTE COMPUTER

When selecting a remote computer, you may wish to make

e Anew TCP/IP connection to a computer you have not connected to before.
Use the TCP/IP tab (see page 42) or LDAP tab (see page 44). Or use the Tim-
buktu Pro Scanner to search for the computer you need (see page 46).

e ATCP/IP connection to a remote computer that you have connected to before.
Use the Address Books or Recent Connections tab (see page 47), or choose a
previously-used connection from the drop-down list on the TCP/IP tab.

e A Dial Direct connection. Use the Dial Direct tab (see page 50.)

CHOOSING A SERVICE

Once you have specified the remote computer you’re connecting to, you must
choose the service you wish you use.

e C(lick a service button on the Services toolbar.
e Choose a service from the Services menu.

The Timbuktu Pro services are addressed in detail in “Chapter 5: The Timbuktu
Pro Services.”
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RE-ESTABLISHING AN EARLIER CONNECTION

If you’ve previously connected to the same remote computer, your connection
properties will have been saved to the Recent Connections tab. Or you may have
created an address book entry for the computer you want. On the Address Books
or Recent Connections tab, double-click the selected address to connect using the
default service (the service used during the last connection) for that address. You
may also be able to reconnect from the TCP/IP tab by clicking the TCP/IP Address
drop-down list and selecting the remote address, or from the Dial Direct tab by
clicking the Phone Number drop-down list and selecting the phone number.

For information about saving connection properties to the address book, see “Us-
ing the Address Books” on page 48.

USING A TIMBUKTU PRO CONNECTION DOCUMENT

You may save connection properties to the desktop for quick access using a Tim-
buktu Pro Connection Document. Timbuktu Pro Connection Documents are desk-
top shortcuts that allow you to start a Timbuktu Pro connection to a specific
remote computer from a desktop icon.

Connection Documents are created by right-clicking over the desktop and choos-
ing New » Timbuktu Pro Connection Document. For more information on creating,
editing, and using Timbuktu Pro Connection Documents, see “Timbuktu Pro Con-
nection Documents” on page 52.

MAKING A NEwW CONNECTION

You can establish a Timbuktu Pro connection to a computer you haven’t used be-
fore in several ways. You may enter its IP address, Timbuktu Pro computer name,
or email address in the TCP/IP tab. You may search for remote computers meeting
specific criteria in the LDAP tab. Or you may use the Timbuktu Pro Scanner to
search your network for active Timbuktu Pro computers.

You may also establish a Dial Direct connection. See “Making a Dial Direct Con-
nection” on page 5o.
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UsiNG THE TCP/IP TaB

The most common way to open a new Timbuktu Pro connection is to use the
TCP/IP tab in the main Timbuktu Pro window.

To MAKE A NEW CONNECTION

1. To connect to a remote computer for the first time, click the TCP/IP tab and
enter the address of the computer you want to connect to.

& Timbuktu Pro - Comaet [0 ]
File Edit Wiew Setup Services Connections Help
=L
B = L | q EEJ
Send Exchange Control  Observe  Motify Chat Intercom  Invite
Addiess | [ 75 Becent & TCRAP . LDAP| #Mpy Dial
LEEJ Books E’l Connectionz E % g Direct
TCP/IP Address: |123.458.34_2E4 j
Type in the name or address of An [P address should be of the form:
the remote computer wou wish 163176.4.43
to connect ta.
An [P DNS name should be of the form:
name.host.com
An [P WINS name is ke a DNS name
but may contain zpaces of the farm:
Dept MT Server
An Intemet Locator name should be of
the form: nameEcompany. com
[Fieady | My Address : 163.176.4.43 Y

You may enter the computer’s IP address, or its DNS name or WINS name if
one has been assigned.

If you don’t know the IP address, and the Internet Locator service is enabled
on the remote computer, you may enter the computer user’s email address.
See “The Internet Locator” on page 24 for more information about the Inter-
net Locator.

2. Choose any service from the Services menu or click on the service button—
Send, Exchange, Control, Observe, Notify, Chat, or Intercom—that you want
to use.

For detailed information about each service, see “Chapter 5: The Timbuktu
Pro Services.”
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3. To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission. See the following section, “Con-
necting as a Registered User or Ask for Permission User.”

CONNECTING AS A REGISTERED USER OR ASK FOR PERMISSION USER

If you attempt to connect to a remote computer using a Timbuktu Pro service that
is not assigned to Guest Users, the Log In dialog box will appear on your screen.

If you have a Registered User account on the remote computer, select the Log In
as Registered User radio button. Enter your log in name and password and click
OK. (You may also change your password if desired or if prompted to do so.)

If you do not have a Registered User account, ask for permission to access the re-
mote computer. Select the Ask for Permission radio button and click OK. If the
user of the remote computer grants your request, you will be admitted.

Note: The user of the remote computer may have disabled the Ask for Permission
option. If the Ask for Permission radio button is not available, you must use other
means to contact the remote user to be granted access.

USING THE LDAP SERVER TO FIND A REMOTE COMPUTER

The LDAP tab in the main Timbuktu Pro window allows you to search for other Tim-
buktu Pro computers when you don’t know their IP addresses. Once the desired
computeris found, you may connect to it without leaving the LDAP tab.

Note: The LDAP tab appears only if Enable LDAP Directory Feature is selected in
the LDAP Options dialog box.



Making a New Connection

To FIND A REMOTE USER USING THE LDAP SEARCH FEATURE
1. Inthe main Timbuktu Pro window, click the LDAP tab.
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¥ Timbuktu Pro - Comet (O] %]
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Books E’] Connections E il Direct
Search For: Itimbuk‘lu* Find Maw | g
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2. Inthe Search For box, type a search string. This can be some portion of the
remote user’s login name, computer name, email address, or any other infor-
mation stored in their user profile. Enter * as a wildcard character when you
are not certain of the entire search string.

3. Click Find Now and Timbuktu Pro will search the LDAP server for users whose
profiles include your search string. Up to 500 entries will be returned, unless
your system administrator has set a different value.

To make a Timbuktu Pro connection to the desired computer, click the com-

puter’s name in the list of computers and choose a service from the Tim-
buktu Pro Service toolbar. Or right-click on the user’s name and choose a
service from the shortcut menu.
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SCANNING YOUR NETWORK FOR TIMBUKTU PRO
COMPUTERS

The Timbuktu Pro Scanner helps you find and connect to remote computers, even
when you don't know their IP addresses, by browsing your local network for active
Timbuktu Pro computers. Once the desired computer is found, you may connect
to it without leaving the Timbuktu Pro Scanner.

By default, the Timbuktu Pro Scanner scans the local TCP/IP subnet. Your system
administrator can customize and extend the range of the Timbuktu Pro Scanner
search.

TOo MAKE A CONNECTION USING THE TIMBUKTU PRO SCANNER

1.
2.

From the Connections menu, choose Timbuktu Pro Scanner.

The Timbuktu Pro Scanner window opens. The search begins automatically.
The remote computers found by the Timbuktu Pro Scanner appear in the Tim-
buktu Pro Scanner window.

-l

Timbuktu Pra has been detected on:
Computer Name | IF Address |
DENT 2401 3025
BLzaK, 2401.30.26
HLRINGER 24013024
ELRATN 24013023

& blue 240.1.30.21

Search | Save I Exit I

|F| eady

When the scan is complete, the word Ready will appear in the status bar at
the bottom of the Timbuktu Pro Scanner window.

To make a Timbuktu Pro connection to a listed computer, right-click the com-
puter name. From the shortcut menu, choose the service that you wish to
use.

To complete the connection to the remote computer, you may need to log on
as a Registered User or ask for permission.
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To SAVE ADDRESSES FROM THE TIMBUKTU PRO SCANNER

Saving frequently-used TCP/IP addresses in an address book allows you more
convenient access in the future. You may save the results of a Timbuktu Pro scan
in a custom address book, enabling future connections without requiring you to
run the Timbuktu Pro Scanner.

1. Inthe Timbuktu Pro Scanner window, click the Save button.
2. Specify a file name for the new address book and click Save.

3. If desired, edit the new address book to add additional addresses or remove
addresses you don’t need.

For more information about creating, editing, and using address books, see “Us-
ing the Address Books” on page 48.

RE-ESTABLISHING A PREVIOUS CONNECTION

When you connect to a remote computer, a record of the connection is saved to
the Recent Connections tab in the main Timbuktu Pro window. If you use the
TCP/IP tab or Dial Direct tab to connect, a connection record is saved to that tab
as well. Finally, you may save previous connections to an address book (on the
Address Books tab) to make future connections easier.

Note: Dial Direct connections are not recorded in the Recent Connections tab and
cannot be saved to address books. Use the Phone Number drop-down list on the
Dial Direct tab.

TO RE-CONNECT TO A REMOTE COMPUTER

1. Select an address to make a connection to the remote computer. You can
select a previously connected remote computer in one of the following ways:

e Select an address from the Address Books tab if you have previously
stored the address in an address book. (See “To save an address to an
address book” on page 48.) If the address book you need is closed, open
it using the procedure on page 49.

e Select a previously-used computer in the Recent Connections tab.
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e Onthe TCP/IP tab, the last 20 connections you made are saved to the
TCP/IP Address drop-down list. Select a TCP/IP address from the list and
choose a service.

e Onthe Dial Direct tab, the last 16 telephone numbers you dialed are
saved to the Phone Number drop-down list. Select a number from the
Phone Number drop-down list and click Dial.

2. Onceyou have selected an address, click a service button to connect using
the chosen service. Or right-click the address to open a submenu from which
you can choose the service to launch. If you select multiple addresses, the
same service is invoked for each of the selected addresses.

Note: Double-clicking an entry in an address book or on the Recent Connec-
tions tab launches the default service selected for the remote computer. You
can also select the computer and press ENTER.

USING THE ADDRESS BOOKS

An address book is a collection of Timbuktu Pro addresses. You can add and de-
lete addresses at any time. Each address includes the computer name, its IP ad-
dress, the default service (the service that will be used when you double-click the
address), and a description of the address. You can have multiple address books.

When an address appears in an address book, it does not guarantee that the
computer at that address is currently running Timbuktu Pro. If Timbuktu Pro is not
running on the remote computer, or if the computer is shut down, you will not be
able to connect.

In addition, some TCP/IP addresses may change. They can be automatically re-as-
signed to computers other than the ones appearing in your address books. If your
organization uses dynamic TCP/IP addressing, you may not want to store IP ad-
dresses in Timbuktu Pro’s address books.

To SAVE AN ADDRESS TO AN ADDRESS BOOK

1. On the Recent Connections tab, select the address you wish to save and click
the Copy to Address Book button. Or, on the TCP/IP tab, enter the IP address
(or email address) you wish to save, and click the Copy to Address Book
button.

2. Inthe Copy dialog box, select the address book to which you want to copy
the address. Click OK.
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The address will be saved to the selected address book.

Note: You cannot save Dial Direct phone numbers or LDAP search results to
an address book.

TO CHANGE THE PROPERTIES OF A SAVED ADDRESS

1. Inthe main Timbuktu Pro window, click the Address Books tab.

2. Select an address book from the Address Book drop-down list. The address
in the selected address book appear in the Address List box.

3. Right-click an address to display a shortcut menu.

Timbuktu Pro

Exchange... Ctrl+E

Copy To... Ctrl+Y

Properties Alt+Enter gz::rovlé ' EEE::;;

Create Shortocut on Desktap

Delete Del Motify... Ctrl+M
Chat... Ctrl+&
Intercom... Ctrl+M
Invite... Ctrl+1

e Choose Timbuktu Pro to access any of the Timbuktu services. If multiple
addresses are selected, the service is invoked once for each address that
is selected.

e Choose Copy To to copy the selected address into another address book.
You can select the destination address book from the list of open
address books in the Copy window. Or choose New Book to create a new
address book.

e Choose Properties to modify the description, address, and default ser-
vice for the selected entry in the address book. The Properties dialog box
appears.

e Choose Create Shortcut on Desktop to create a shortcut on the desktop
for the selected address.

e Choose Delete to delete the selected address from the address book.

To OPEN AN ADDRESS BOOK

1. From the File menu, choose Open Address Book. The Open File dialog box
appears.

2. Select an address book (a file with a .tbk extension) and click Open. The
selected address book is added to the Address Book drop-down list on the
Address Books tab in the main Timbuktu Pro window.
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TO CREATE A NEW ADDRESS BOOK

1. On the Recent Connections tab, select any address and click the Copy to
Address Book button. Or, on the TCP/IP tab, enter any IP address (or email
address), and click the Copy to Address Book button.

2. Inthe Copy dialog box, click the New Book button.

3. Inthe New [Address Book] dialog box, in the File Name area, enter a name for
the new address book. Then click Save.

4. The new address book is created and is shown in the Copy dialog box. To
save the address you selected in step 1 to the new address book, click OK. To
keep the new address book without saving the selected address to it, click
Cancel.

MAKING A DIAL DIRECT CONNECTION

The Dial Direct tab in the main Timbuktu Pro window allows you to make a direct
modem-to-modem connection to another Timbuktu Pro computer equipped with
a modem.

When using Dial Direct, no TCP/IP network connection is required. However, Dial
Direct connections use the TCP/IP protocol. You must have TCP/IP networking
software installed and configured on your computer.

Use the text boxes and drop-down lists to enter the complete phone number you
wish to dial. The 16 most recently dialed numbers are saved in the Phone Number
drop-down list. You cannot save Dial Direct numbers to the Recent Connections or
Address Books tab.

Note: The Dial Direct tab appears only if a Windows-recognized modem is
installed in your computer.
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To ESTABLISH A DIAL DIRECT CONNECTION

1. Inthe main Timbuktu Pro window, click the Dial Direct tab.

% Timbuktu Pro - Comet _ O] x|
File Edit WView Setup  Services Connections  Help

G E e e O

Send Ewschange Contral  Observe  Matify Chat Inkercom it
Address | (5 Becent - TCRAP . LDAP 2= Dial
LEEJ Books E’l Connections QE | % Direct

Type in the phone number of the remote
computer you wish to connect to.

Country Code: IUnited States of America [1) j

Area code: 10 x

Phane number: |21 0-3423 =l P |
Dial: 70,9 210-3423

Dialing fram: INetopia, Ine. 'l Dialing Properties. .. |

[Ready | My Address : 163.176.4.43 Y

2. Choose a country code from the Country Code drop-down list. (This list is
maintained by the Windows 0S.)

3. Enterthe area code in the Area Code box. If you have connected to phone
numbers in this area code before, you may choose the area code from the
drop-down list. If you do not enter an area code, Timbuktu Pro assumes that
you are making a local call and will not dial an area code.

4. Enterthe phone numberin the Phone Number box. If you have dialed this
number before, you may also choose it from the drop-down list.

The complete phone number is displayed at the Dial line exactly as it will be
dialed. If you used Dialing Properties to disable call waiting or enable a dial-
ing prefix, the appropriate dialing sequence will be displayed preceding the
number. See your Windows or modem documentation for more information

about setting options in the Dialing Properties dialog box.



52/ Chapter 4: Making a Timbuktu Pro Connection

5. Choose Dial to dial the number and begin a Dial Direct connection. The
Modem Status window will appear to help you monitor your connection. For
more information about the Modem Status window, see the online Help.

6. Once the connection is established, you may launch any Timbuktu Pro ser-
vice normally, except Intercom. All services work in the same way as they do
over a TCP/IP connection.

TIMBUKTU PRO CONNECTION DOCUMENTS

Timbuktu Pro Connection Documents are desktop shortcuts that allow you to start
a Timbuktu Pro connection to a specific remote user by double-clicking a desktop
icon. You may also right-click the Connection Document to display a shortcut
menu. Choose Timbuktu Pro » Any Service to establish a connection using the
chosen service.

&
...

Print

Timbuktu Prio 123.456.34.23 (Send)
Send Tao »  Send
cut Exchange
Copy Cantrol
= Observe
Create Shorkout Motify
Delete Chat
Rename Intercom
- Irvite
Properties

To CREATE A NEW CONNECTION DOCUMENT
There are several ways to create a new Connection Document.

e Specify a remote computer on the Address Books, Recent Connections, or
TCP/IP tab in the main Timbuktu Pro window. Then click the Edit menu and
choose Create Shortcut on Desktop.

e Specify a remote computer in the Address Books, Recent Connections, or
TCP/IP tab. Then type CTRL+D.
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e Right-click on your desktop and choose New » Timbuktu Pro Connection
Document. You will need to specify an address before you can use the new
Connection Document.

Once the shortcut is created, you can rename it by right-clicking on it. From the
shortcut menu, choose Rename. Do not change the .tmb extension.

If you wish to change the address or default service of one of your Connection
Documents, or if you created it without specifying a remote computer, you will
need to change its properties.

To CHANGE THE PROPERTIES OF THE CONNECTION DOCUMENT

1. Right-click the Connection Document. From the shortcut menu, choose Prop-
erties. The Properties dialog box appears.

2. Click the Timbuktu Pro Properties tab.

Send to Goofball. TMB Properties HE

Generall Securty  Timbuktu Pro Properties |

Connect ta remaote computer using...
Address:
|1 23.456.34.23

Default Service:

ISend j

ak I Cancel | Lpply |

3. Enter or modify the remote computer address in the Address field.
4. Modify the Default Service by choosing a service from the drop-down list.
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CHAPTER 5: THE TIMBUKTU PRO SERVICES

This chapter introduces you to each of the many Timbuktu Pro services: Send, Ex-
change, Control, Observe, Notify, Chat, Intercom, and Invite. (The Control and Ob-
serve services are collectively known as Remote Control.) Each Timbuktu Pro
service allows you to interact with remote computers in a different way; together,
they help you make the most of your network.

SEND: SENDING FLASHNOTES AND FILES TO REMOTE COMPUTERS

Timbuktu Pro’s Send service can send messages similar to electronic mail, called
FlashNotes, to another computer. You can also attach files and folders to the mes-
sages and send them to other computers easily.

Timbuktu Pro temporarily stores the files you send in a specific folder on the re-
mote computer. Likewise, remote users can send files only to your files received
folder, which you specify on the Send tab in the Preferences dialog box.

Send does not allow remote users to see the folders on your computer. Once you
receive the files, you can save them to any directory you wish.

To SEND A FLASHNOTE TO A REMOTE COMPUTER

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Send. Or click the Send service button. The
FlashNote window is displayed. (Note that you may need to ask for permis-
sion or log in as a Registered User before the window opens.)

/55
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4 FlashNote [H[=] E3

Tar 123.456.34.23

IMeszage: |Eric: Here are the files we discuszed pesterday. Please let me know if ﬂ
lvou'd like any changes.

=
Eiles: L3 d\business plan
d:\Denver Presentationshelide show. ppt
Help | Lancel | Send |
l Total size of the files attached to this note: 1.3 M

3. Tosend a note, type a message in the upper panel.

To include files with your message, click the Add Files button. The Add Files
to Send dialog box appears.

Look jn: IaDenver Presentations j gl

E logo. gif
9] netopia_letterhead. doc
h_E. overview. doc
EI‘ slide show.ppt

[ dbusiness plan

Add
EI‘ [:\Denver Presentations'slide show. ppt

Eemove

Help

£ L

Tatal size of the files attached to this note: 1.3 M Done | Cancel

Note: You may also drag and drop files and folders from the desktop or from
Windows Explorer into the Files area in the FlashNote window.
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In the Add Files to Send dialog box, locate and display the source folder in
the upper panel.

Select the files you want to add in the upper panel and click the Add button.
The files that you select in the upper panel appear in the lower panel. If you
wish to remove a file that you added, select the file in the lower panel and
click the Remove button.

Note: You may also drag and drop files and folders from the desktop or from
Windows Explorer into the lower panel of the Add Files to Send dialog box.

Click the Done button when you have finished selecting files.

Click the Send button in the FlashNote window to send the FlashNote and
files.

To stop a file transfer immediately, click the Cancel button. Timbuktu Pro
stops the file transfer, but the FlashNote is still sent to the remote computer.
In addition, stopping the file transfer does not affect files that have already
been transferred.

When you receive a FlashNote, you may wish to save the FlashNote and any at-
tached files.

To SAVE FLASHNOTES AND FILES

1.

In the FlashNote window, click the Save Files button. The Save Files dialog
box appears.

Select the target drive and the destination folder.

In the lower panel, select the files or folders you wish to save in this location.
Click the Save button.

You may save each file and folder in a different location. When all of the files
have been saved, or when you click Done, the FlashNote window reappears.

If desired, print or save the FlashNote by clicking the Print Note or Save Note
button.

FlashNotes are saved with a default .rtf extension.
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EXCHANGE: COPYING AND MOVING FILES BETWEEN COMPUTERS

With Timbuktu Pro’s Exchange service, you can copy and move files and folders in
both directions between your computer and another Timbuktu Pro computer. Ex-
change provides more flexibility than Send.

To COPY FILES AND FOLDERS BETWEEN COMPUTERS

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Exchange. Or click the Exchange service but-
ton. The Exchange window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)

'w Exchange Files with Echo =] E3
File Wiew
Comet

@ indez hitml

@ logo.gif

nietopia_letterhead doc

averview doc
slide: =hovy ppt

Echo

Remote Drives: I {3 Project #3423

histary pf

@ aystems Htm

coee_|

The upper panel lists the drives, folders, and files on your computer. The
lower panel lists the same information for the remote computer.

3. Locate and display the source and destination folders in the Drives drop-
down lists.

You can use the Create New Folder button create a new destination folder.
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4. Dragthe desired files or folders from the source panel to the desired folderin
the destination panel.

5. Timbuktu Pro begins to transfer the files immediately. The Exchange Files
dialog box appears, indicating the progress of the file transfer.

While Timbuktu is transferring the files, you can

e C(lick outside the Exchange window, or minimize it, to work on other com-
puter tasks.

e (lick Cancel to immediately cancel the transfer. The file being sent when
Cancelis clicked is not transferred, but any files that were previously sent
remain in the destination folder (unless you manually delete them).

6. When you have finished exchanging files, click the Close button.

You can also use the Exchange service while controlling or observing a Tim-
buktu Pro computer.

REMOTE CONTROL: CONTROLLING OR OBSERVING A REMOTE
COMPUTER

You can use Timbuktu Pro to control or observe a remote computer. The desktop
of the remote computer is displayed in a window on your screen. The window is
updated as the other computer’s desktop changes.

While you are controlling another computer, you can perform any of the tasks that
you could perform locally, including opening applications and creating new files.
This means that a user with the Control privilege can remotely create, modify, or
delete files without restriction, and can erase data from the host computer. This
privilege, therefore, should be granted with caution.

While observing another computer, you can see the activity on its screen, but you
cannot control it. This privilege is useful for diagnosing problems on a remote
computer or giving a presentation.

If the remote computer’s screen resolution is higher than yours and you maximize
your Control or Observe window, the AutoScroll feature is enabled so that you can
view the entire remote desktop.
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TO CONTROL OR OBSERVE ANOTHER COMPUTER

1.

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose Control or Observe. Or click on the Control or
Observe service button.

Timbuktu Pro displays the remote computer’s desktop in a screen-sharing
window. (Note that you may need to ask for permission or log in as a Regis-
tered User before the window opens.)

e Ifyou have chosen the Observe option, you will be able to observe the
screen only.

e Ifyou have chosen the Control option, you can use your mouse and key-
board to operate the remote computer.

e Ifthe user of the remote computer has enabled the Use Capture Frame
option on the Observe/Control tab in the Preferences dialog box, the
screen-sharing window will be blank until the remote user clicks the Play
button in the Capture Frame. (For more information about the Capture
Frame, see “Enabling the Remote Control Capture Frame” on page 27 and
“Using the Capture Frame” on page 61.)

e C(lick on a screen-sharing window to make it the active window. To return
to your own computer, click outside the screen-sharing window.

To stop controlling or observing, open the screen-sharing window’s system
menu and choose Close, or click its Close box. Timbuktu Pro closes the win-
dow and ends the connection.

If a screen-sharing window doesn’t open, you may have one of the following
problems:

* You have not been granted permission to use the Control or Observe ser-
vice on the remote computer.

e Timbuktu Pro is not running on the remote computer.

e Thereis a network firewall between the computers.

If the screen-sharing window appears, but remains blank, the user of the
remote computer may have enabled the Use Capture Frame option. Unless
the remote user is present at the computer and allows the screen-sharing
session to proceed, you will not be able to view the remote computer.

If a remote user is controlling or observing your computer while Timbuktu Pro is
minimized, the regular Timbuktu Pro icon in the system tray on the taskbar is re-
placed with an icon that alternates between the regular Timbuktu Pro icon and a
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service icon that indicates you have a remote user controlling or observing your
computer.

Note: If you want to enable or disable the Control or Observe service on your com-
puter, you can do so in the Security dialog box. See “Chapter 6: Security” for
information on granting services to remote users.

While controlling or observing a remote computer, you can start another Timbuktu
connection to the same computer. Open the screen-sharing window’s system
menu (click the Control or Observe icon in the upper-left corner of the screen-
sharing window) and choose another service.

RESHEhE
Mowve

system Size
menuy — Miaimize

Magimize

Close

v Auto Scralling ur
Shrink to Fit

Send
Exchange |
I otify
Chat il
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Help

Send Ctrl+Alt+Del to Remote Computer jarn
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@ Send Carnet
<25 Control Drapdream

Screen-sharing
window

Note: Timbuktu Pro does not support full-screen DOS sessions. Press ALT+ENTER
to switch the MS-DOS session from full-screen to windowed mode.

USING THE CAPTURE FRAME

When the Use Capture Frame option is enabled, the screen-sharing window on
the guest comptuer displays only the portion of the host computer’s desktop that
appears within the Capture Frame on the host computer.
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USING THE CAPTURE FRAME AS A GUEST

To begin any outgoing Control or Observe session, launch the service normally.
The screen-sharing window will open on your desktop (you may need to login as
a Registered User or ask for permission first).

If the Use Capture Frame option is enabled on the host computer, the screen-shar-
ing window will be blank until the user of the host computer clicks the Play button
in the Capture Frame. Once the session begins, the screen-sharing window will
display only the portion of the host computer’s desktop that appears inside the
Capture Frame. The user of the remote computer may move or resize the Capture
Frame at any time. You will be able to use the Control and Observe services nor-
mally, except you will not be able to move or resize the Capture Frame even if you
are controlling the remote computer.

If the Use Capture Frame option is not enabled on the host computer, the screen-
sharing session will proceed automatically.

USING THE CAPTURE FRAME AS A HosT

If the Use Capture Frame option is enabled on your computer and a remote user
begins an incoming Control or Observe session, the Capture Frame will appear on
your desktop. Click the Play button in the upper-left corner of the Capture Frame
to allow the Control or Observe session to proceed. (Until you click the Play but-
ton, the screen-sharing window on the remote computer is blank.)

During the screen-sharing session, only the portion of your desktop that appears
in the Capture Frame is displayed on the remote computer. You may increase or
decrease the size of the Capture Frame or move the Capture Frame around your
computer’s desktop. The remote user will not be able to move or resize the Cap-
ture Frame, even with the Control service.

To close the incoming connection, close the Capture Frame.

If the Use Capture Frame option is not enabled on your computer, any incoming
screen-sharing sessions will proceed automatically, subject to the security con-
trols you have placed on your computer.
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SENDING CTRL+ALT+DEL TO A REMOTE COMPUTER

If you’re connecting to a computer that is running a secure Windows operating
system, and need to log on, you’ll need to open the Logon Information dialog box.
It’s not possible to do this simply by pressing the CTRL+ALT+DEL keys on your
computer. You’ll need to follow the steps below.

To DISPLAY THE WINDOWS LOGON INFORMATION DIALOG BOX

1. Control the remote Windows computer.

2. Click the system-menu button (the Control or Observe icon in the upper-left
corner of the screen-sharing window) and choose Send Ctrl+Alt+Del to
Remote Computer.

The Logon Information dialog box is displayed on the remote computer,
allowing you to enter your user name and password.

You don’t have to log on to Windows to use Timbuktu Pro with a secure Windows
computer. You can exchange files with and send files to a remote computer when
the Logon Information dialog box is displayed. However, FlashNotes are not dis-

played on the Windows system until after you have logged on.

CONTROLLING A MACINTOSH COMPUTER

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. If you need to send a
Command (38) keystroke to the Macintosh, press the Window key on Windows NT-
based computers. On Windows 98 and Windows ME computers, there is no
equivalent to the Command key.

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-
lent of a Command keystroke to the Macintosh. If you disable this option,
pressing CTRL on your Windows keyboard will send a CTRL keystroke to the
Macintosh.
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NOTIFY: REQUESTING NOTIFICATION WHEN THE REMOTE USER IS
ACTIVE

Timbuktu Pro’s Notify service lets you leave a request to be notified when another
Timbuktu Pro computer becomes active. This is a useful way to find out when the
person you want to communicate with is available. You can then call or begin a
Chat or Intercom session with the user of the remote computer.

TO REQUEST NOTIFICATION OF ANOTHER USER’S PRESENCE

1. Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

2. From the Services menu, choose Notify. Or click the Notify service button. The
Notify window is displayed. (Note that you may need to ask for permission or
log in as a Registered User before the window opens.)

P! Notifying Daydream [ O] x]

Waiting for an answer...
Idle Tire: 00:07:07:37
Last Active:
Friday, February 04 2000, 01:39 PM [Local Time]

Salina Regan, VP Engineering ;I
Email: zalinal@timbukhu. com

Phone: 510-320-3318

Fax/todem: 510-210-3423 LI

Help

“Waiting for an answer” appears near the top of the window. Below it are the
following fields:

e [dle Time tells you how much time has passed since the remote user has
used that computer.

e [astActive tells you the date and time the remote user last moved the
mouse or pressed a key. This field changes to Became Active the next
time the remote user moves the mouse or presses a key, and displays
the new date and time.

e The Message area displays any text in the Message field that the remote
user set up.

3. While you’re waiting, you can work on tasks in other windows. You can mini-
mize the Notify window, but don’t close it.

4. Onthe remote computer, the Request for Notification dialog box tells the
remote user that you are asking for notification.



Notify: Requesting Notification When the Remote User is Active | 65

Note: If the remote user has selected Answer Automatically on the Notify tab
in the Preferences dialog box, the Request for Notification dialog box does
not appear. You will be notified immediately when the remote computer
becomes active.

P! Daydream is asking to be notified...
@ D aydrean iz azking to be natified... i
Address: 123456.5.6
\iait time: 00:00:48:26 Igrire
Send | Exchange | Help

Contral | Obzerve |

LChat | rterzam |

When the remote user clicks the Acknowledge button in the Request for Noti-
fication dialog box, the message in your Notify window changes to

“Name is there.”

P! Notifying Daydream M= 3

Draydrean is there. oK
[el= vz |

Became Active:

Friday, February 04 2000, 01:43 PM [Local Time) ’ )
Motify Again |
Salina Regan, ¥P Engineering ;I

Email: salina@Etimbuktu. com Chat
Phaone: 510-320-3318 —
Fax/Modem: 510-210-3423 LI

Intercom

The remote user also has the option of clicking the Chat, Intercom, or Ignore but-
ton. If the remote user clicks the Ignore button when you ask for notification, the
Notify window on your computer will remain unchanged, even though the remote
user has become active.

Once you have been notified of the remote user’s return, you can close the Notify
window and call the other user, or you can use any of the additional buttons that
are now displayed—Notify Again, Chat, or Intercom.

If the Notify window is acknowledged while you are away from your computer, the
remote user may no longer be at their computer by the time you get back. You can
start the notification process again by clicking the Notify Again button and return-
ing to step 3.

If you want to initiate a keyboard conference or a voice communication with the
other user, click the Chat or Intercom button.
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CHAT: CHATTING WITH A REMOTE USER

The Chat service lets Timbuktu Pro users and their guests post messages to one
another interactively. For example, if you are already in the midst of a file transfer
session, a Chat session lets you discuss the file transfer with the other user.

TO CHAT WITH A REMOTE USER

1.

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose Chat. Or click the Chat service button. The
Chat window is displayed. (Note that you may need to ask for permission or
log in as a Registered User before the window opens.)

© Chat with Daydream IS [=] B3

N
< Comet > Hey. Did you review the filez | zent last week?

< Daydream > 1'm warking through them now. Can we

meet this afternoon?

Great, Il

\_l‘_th

Send

Dizconnect | Frint | Save | Help

|E0nnec:ted

Type your first message and press ENTER or click the Send button.

Your message is copied to the transcript panel in the upper part of the win-
dow and to the Chat window on the remote computer. Type more messages
immediately or wait for a reply from the other user.

The reply is displayed below your message in the transcript panel. You can
keep typing messages back and forth as long as you like.

When you’ve finished chatting, click the Disconnect button. When either
party disconnects, the session is ended, and the message at the bottom of
the window changes to Disconnected.

After you have disconnected, you can print or save the chat-session details.

e (Click Print to print the chat-session details.

e (lick Save to save the chat-session details to a rich text file (with an .rtf
extension).
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8. Click the Close button in the upper-right corner to close the Chat window.

You can chat with more than one other user at the same time, but you will need to
open a separate Chat session with each participant. For this reason, you cannot
chat with multiple users over a Dial Direct connection.

INTERCOM: SPEAKING TO A REMOTE USER

The Intercom service lets Timbuktu Pro users talk to each other through their com-
puter’'s audio hardware.

The Intercom service is not available over Dial Direct connections.

To SPEAK TO ANOTHER TIMBUKTU PRO USER

1. Select the remote computer. (See “Chapter 4: Making a Timbuktu Pro Con-
nection.”)

2. From the Services menu, choose Intercom. Or click the Intercom service but-
ton. The Intercom window is displayed. (Note that you may need to ask for
permission or log in as a Registered User before the window opens.)

@ Intercom with RAGE !E[E
I 2

Speaker Yolume:  Low '_J_ High

™ Mute Mike
=} Using Headphones onHandset (FulliDuples]

Sound Compression:
|G5M (High Speed Modem, 13kbs] =l

Feceiving: G5M Compreszion

Metwork Reliability: — 100%  Transmit
100% Receive

Status: Idle

Help | LCloze |

Note: If the sound card on your computer or the remote computer is already
being used by another application—for example, recording or playback—you
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won’t be able to begin your Intercom session until the other application has
been closed.

When the Intercom window is displayed, you can begin speaking with the
remote user.

Note: The Intercom window does not automatically stay on top of the screen
when other application windows are run in the foreground.

When you’ve finished talking, click Close.

INVITE: INVITING A REMOTE USER TO ACCESS YOUR COMPUTER

The Invite service allows you to invite other users to access your computer. Once
you have specified a remote computer to receive your invitation, you can select
the type of invitation you want to extend and send it to the remote user. Awindow
opens on the remote computer, inviting the remote user to begin the Timbuktu
Pro session. The recipient will be able to connect to your computer using the ser-
vice you specify, or decline your invitation by closing the Invite window.

TO INVITE A REMOTE USER TO ACCESS YOUR COMPUTER

1.

Select the remote computer or establish a Dial Direct connection. (See
“Chapter 4: Making a Timbuktu Pro Connection.”)

From the Services menu, choose /nvite. Or click the /nvite service button. The
Invite window is displayed.

invite x|

Inwvite RAIN to connect with service:

Send | Exchange |
Control | Obszerve |
Chat | Intercom |

In the Invite window, click a service button to specify the service you wish to
invite the other user to access.

Depending on the remote computer’s settings, you may need to ask for per-
mission or log in as a Registered User before the Invite process continues.
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4. The Invite window appears on the remote computer, indicating the service
you invited the remote user to use.

You have been invited x|
The uzer of RAIN invites

you to an obzerve seszion.

Do you wish to start this session? ﬂl

The remote user may click Start Session to launch the Timbuktu Pro service or
Cancel to close the Invite window.

Note: On Macintosh computers, the service window opens automatically. The
Macintosh user may begin using the service or close the window to cancel it.

When the remote user accepts the invitation and the Timbuktu Pro service is
launched, the remote user’s computer becomes the guest computer and the local
computer becomes the host computer. Normally, when you launch a Timbuktu Pro
service, your local computer is the guest computer.
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CHAPTER 6: SECURITY

Timbuktu Pro offers multiple levels of security that help you restrict access to the
different Timbuktu Pro services on your computer. Remote Timbuktu Pro comput-
ers can connect to your computer as several kinds of remote users: Guest Users,
Registered Users, Ask For Permission Users (or temporary guests), and Windows
NT Users (Windows NT-based hosts and guests only). Each kind of user can be
granted different levels of access.

Timbuktu Pro will alert you when remote users access your computer. The Tim-
buktu Pro icon in the system tray on the taskbar alternates with a service icon in-
dicating the presence of a remote user. You can disconnect remote users at any
time.

The activity log keeps a record of all remote computers that access your computer,
along with the services used. Finally, you can use a Timbuktu Pro master pass-
word to prevent a user with direct access to your computer from changing any of
your Security, Preferences, or LDAP settings.

TIMBUKTU PRO REMOTE USERS

Timbuktu Pro allows you to specify many different levels of remote-user access.
You can allow all users to access certain services, and limit other services to pass-
word-authenticated users.

Guest User access is available to all remote Timbuktu Pro users. You do not have
to assign any services to Guest Users, or you can select specific Timbuktu Pro ser-
vices you wish to make available to them. A Guest User does not have to supply a
user name or password to access the services you have assigned to guests.

Guest Users are normally assigned a limited range of services because guest ac-
cess is open to anyone without authentication. Services such as Send and Notify
are often assigned to guests; services such as Control and Exchange are almost
never assigned to guests. By default, Guest Users are granted the Send and Notify
services.

[ 71
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If you enable the Ask For Permission option, a guest who does not have permis-
sion to use a particular service can request permission to use that service on a
one-time-only basis. If a remote user attempts to connect to your computer using
a service he or she has not been granted, a dialog box will appear on your screen
giving the name of the remote computer and specifying the service the user
wishes to access. (You may also require individual Registered Users and Windows
NT Users to ask for permission after they are authenticated.) See “Ask for Permis-
sion Access” on page 81.

The Admit Temporary Guest feature is similar to the Ask for Permission feature
and is provided for compatibility with earlier versions of Timbuktu Pro.

Registered Users must supply a user name and password to access your com-
puter. You can create a Timbuktu Pro account for as many Registered Users as you
wish, and assign each user a specific set of access privileges. A Registered User
can access the services you have assigned to the Registered User account any-
time Timbuktu Pro is running on your computer.

Registered User status on one computer does not give the user the ability to con-
nect to any other remote computer. Access to Timbuktu services is granted on a
computer-by-computer basis.

Windows NT Users are the users and user groups on your Windows network who
have been granted permission to use specific Timbuktu Pro services on your com-
puter. The Windows NT Users you create are similar to Registered Users, but—
because they have already been authenticated by logging in to the Windows
network—they do not need an additional password to access your computer.

Note: Privileges granted to Guest Users are automatically granted to Registered
Users and Windows NT Users. You cannot withhold a privilege from a Registered
User and Windows NT User if that privilege is granted to guests.

THE SECURITY DIALOG BOX

The Security dialog box controls the security configuration for your computer.
There are three tabs in the Security dialog box: Guests, Registered Users, and NT
Users. These tabs allow you to

e Specify which Timbuktu Pro Services will be available to Guest Users.

e Specify whether guests will be able to ask for permission to use services you
haven’t assigned them.

e C(Create, modify, and remove Registered User accounts.
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e Set password restrictions for Registered User accounts.
e Assign privileges to Windows NT Users (including users of Windows 2000,
Windows XP Pro, and Windows 2003).

The following sections describe how you can use the Security dialog box to con-
figure Timbuktu Pro security.

If a master password is specified for your computer on the Master Password tab in
the Preferences dialog box, you’ll have to supply the master password to access
the Security dialog box. (See “Setting Up Your Master Password” on page 32.)

MANAGING TIMBUKTU PRO USERS

Before other computers can use Timbuktu Pro to connect to your computer, you
must assign privileges to Guest Users, Registered Users, or Windows NT Users.

ASSIGNING SERVICES TO GUEST USERS

A service assigned to Guest Users is available to anyone who connects to your
computer using Timbuktu Pro. Remember to exercise caution when granting a ser-
vice to Guest Users. A Guest User does not have to enter a password to use the
service, and you are not prompted to give permission before the session begins.
However, the Timbuktu Pro icon in the system tray will indicate that a user has
connected to your computer (see “Monitoring Remote Connections” on page 84).

TO GRANT SERVICES TO ALL GUEST USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

Gussts | Registered Usersl NT Usersl

Check the services you wizh to grant to Guests
v Send [T Exchange [Fead)
™ Cantral ™ Ezchange [wiits]
[ Observe [" Exchange [Delete)
™ Chat ™ Intercam

I Matify ¥ Irite:

¥ Guests may ask For permizsion to use unchecked services.

Cancel Apply Help
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2. Onthe Guests tab, select the services you wish to grant to all Guest Users.

3. Ifyou wish to let remote users ask for permission to use services you have
not assigned to Guest Users, select Guests May Ask For Permission to Use
Unchecked Services.

4. Click OK to save your changes and close the Security dialog box.

You can return to the Security dialog box at any time to change access privileges.

DEFINING REGISTERED USERS

Registered Users must supply a user name and password to access your com-
puter. You can create Timbuktu Pro accounts for as many Registered Users as you
wish, and assign each user a specific set of access privileges. If desired, you can
require Registered Users to ask for permission after they have been authenticated
but before they can connect to your computer.

A Registered User can access the services you have assigned to the Registered
User account anytime Timbuktu Pro is running on your computer.

When you wish to grant a remote user permanent, password-protected access to
your computer, you will define a Registered User account.
To ADD A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.
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Security E

Guests Redistered Users | NT Users |

Azzign user's name and password...

Jim
Michel Name: IAnne
Password: I ******
Confirm; | ******
— Check the services to grant
¥ | Send W Exchange [Flead)
¥ Congral V¥ Exchange [Wwiite]
Add Fegistered User | I Observe ¥ Exchange [Delete)
e " Chat ™ Intercom
] [ | Hstify
Bemove Registered User | o i

| On Host Service Request:
[V Ask For Host Permission
Defaultto & no  yes

in IT seconds
Ok I Cancel | Apply | Help I

Pagzword Restrictions...

Click the Add Registered User button to create a Registered User called “New
User.”

In the Name text box, enter the user name the Registered User will use to
connect to your computer.

In the Password and Confirm text boxes, enter the password the Registered
User will use to connect to your computer. The password is case-sensitive.

You will not be able to close the Security dialog box until the text in the Pass-
word and Confirm text boxes matches exactly.

During the log-in procedure, the Registered User is free to change the pass-
word as long as the replacement password conforms to any password restric-
tions you have set. See “Setting Password Restrictions” on page 76.
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In the Check the Services to Grant area, select the services you wish to grant
to this Registered User.

Services granted on the Guests tab are automatically granted to all Regis-
tered Users as well. For example, if you grant the Observe service to Guest
Users, you cannot deny this service to Registered Users. It will be dimmed in
the Registered Users tab.

Check the Ask for Host Permission box if you want the option to reject con-
nection attempts by this Registered User.

This allows you additional security beyond Registered User authentication.
After the Registered User’s user name and password are verified, the Ask for
Permission dialog box will appear on your screen. You can click OK to accept
the connection or Cancel to deny it.

Use a Default To radio button to automatically accept or reject the connection
when you are unable to answer the request within the time period specified
in the Seconds box.

If the Registered User attempts to access services you have granted to Guest
Users, you will not be given the opportunity to reject the connection. Guest
User access will be granted automatically.

If the Registered User attempts to connect using a service you have not
granted in the Check Services to Grant area, the attempt will appear as an
Ask For Permission request. (See “Ask for Permission Access” on page 81.)

Click Password Restrictions to enforce password restrictions on the Regis-
tered Users connecting to your computer. For more information, see the fol-
lowing section, “Setting Password Restrictions.”

Click OK to save the new Registered User and close the Security dialog box.

SETTING PASSWORD RESTRICTIONS

When you click the Password Restrictions button on the Registered Users tab in
the Security dialog box, the Password Restrictions dialog box appears.

Password Restrictions [ x]

Enforce these password restrictions on uzers connecting ta this computer

[+ Minimurn number of characters in passwords |4
V' Mumber of days until password expires |3U

Help | 1] I Cancel |
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There are three options that may increase the security of the passwords used by
your Registered Users.

e Passwords Can’t Match the Three Previous Passwords prevents the Registered
User from reusing recently-used passwords.

e  Minimum Number of Characters in Passwords requires Registered Users to
choose passwords of a minimum length, which may make them more difficult
to guess.

e Number of Days Until Password Expires requires Registered Users to define
new passwords on a regular basis.

CHANGING OR REMOVING A REGISTERED USER ACCOUNT

If the privileges you have assigned a Registered User become inadequate for your
needs, orif the user no longer requires access to certain services, you may wish to
change the Registered User account privileges. If a Registered User no longer re-
quires access to your computer, you may wish to remove the Registered User ac-
count.

To CHANGE A REGISTERED USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

3. Select the desired Registered User from the list on the left side of the dialog
box.

4. Tochange the user’s name or password, select it and type the new value. If
you change the password, you will have to type it again in the Confirm field.

5. Select or clear the services you wish to grant or deny.
Click OK to save your changes and close the Security dialog box.

To REMOVE A REGISTERED USER ACCOUNT
1.  From the Setup menu, choose Security. The Security dialog box appears.
2. Click the Registered Users tab.

3. Select the desired Registered User from the list on the left side of the dialog
box.

Click Remove Registered User to remove the Registered User.
5. Click OK to save your changes and close the Security dialog box.
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DEFINING WINDOWS NT USERS

Using the NT Users tab in the Security dialog box, you can assign Timbuktu Pro
privileges to Windows users and groups on Windows NT-based networks.

A Windows NT User account allows a Windows user (or user group) to access Tim-
buktu Pro services on your computer. Because these users are authenticated
when they log in to Windows, Timbuktu Pro does not require them to use an addi-
tional password when they connect to your computer. If desired, you can require
Windows NT Users to ask for permission after they have been authenticated but
before they can connect to your computer.

The NT Users tab in the Security dialog box appears only when the following con-
ditions are met:

¢ The local operating system is Windows 2003, Windows XP Pro, Windows
2000, or Windows NT 4.0 with Service Pack 6 or higher.

e The local Windows user has privileges to read user/group settings from the
operating system.

ADDING A WINDOWS NT USER ACCOUNT

To allow Windows-authenticated users access to your computer, you will define a
Windows NT User account.

To ADD A WINDOWS NT USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the NT Users tab.

Security

Guestsl Registered Users  NT Users |

— Check the services to grant—
i Send

™ Contral

{7 Dbseve

I Chat

7 Notify

{7 Ewchange

7 Intercom

T lrwite
On Guest Service Reguest:

[V Ask For Host Permission
4 »
—I—I —I Default to & no O yes

Add | Bemove | in I 20 seconds.

ak. I Cancel | Apply | Help
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Click the Add button. The Add Users and Groups dialog box appears.

Add Users and Groups [ ]
List Mames From; I@ oPs j

Dornain_Admins |
Domain_Guests

Drornain_Users

danaw

danr hd
a4 I I 13

Lodd | fembers |

PR
L

Add Names :
— Check the services to grant——

allena
Execs ¥ Send
Legal 7 Contral

{7 Observe
¥ Chat

i Matify

{7 Exchange
7 Intercom

7 lrite

V¥ sk For Host Permission
Defaultta % no © pes

in I 30 seconds
i
Bemove ak. I Cancel |

\_E

You can select existing Windows users and groups in the Add Users and
Groups dialog box. You cannot create new users or groups.

Select a Windows domain from the List Names From drop-down list. This will
list the users and groups in the selected domain.

Select a user or group in the Names list and click Add to add it to the Add
Names box.

If you select a user group, you may also choose Members to list the users
included in the group. You may then add individual members of that group,
or add the entire group.

Select a Windows user or group in the Add Names box and specify the ser-
vices you wish to grant.

Note: Services granted to all Guest Users in the Guests tab are automatically
granted to all Windows NT Users as well. For example, if you grant the
Observe service to Guest Users, you cannot deny this service to Windows NT
Users.
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Check the Ask for Host Permission box if you want the option to reject con-
nection attempts by the selected user or user group.

This allows you additional security beyond Windows authentication. After
the Windows NT User’s identity is verified, the Ask for Permission dialog box
will appear on your screen. You can click OK to accept the connection or Can-
cel to deny it.

Use a Default To radio button to automatically accept or reject the connection
when you are unable to answer the request within the time period specified
in the Seconds box.

If the Windows NT User attempts to access services you have granted to
Guest Users, you will not be given the opportunity to reject the connection.
Guest User access will be granted automatically.

If the Windows NT User attempts to connect using a service you have not
granted in the Check Services to Grant area, the attempt will appear to you as
an Ask For Permission request. (See “Ask for Permission Access” on page
81.)

Click OK to save your changes and close the Add Users and Groups dialog
box.

Click OK to close the Security dialog box.

CHANGING OR REMOVING A WINDOWS NT USER ACCOUNT

If the privileges you have assigned a Windows NT User become inadequate for
your needs, or if the user or group no longer requires access to certain services,
you may wish to change or delete the Windows NT User account privileges.

To moDIFY A WINDOWS NT USER ACCOUNT

1.

2
3
4.
5

From the Setup menu, choose Security. The Security dialog box appears.
Click the NT Users tab.

In the User List box, select a Windows NT User.

Select or clear the services you wish to grant or deny.

Click OK to save and close the Security dialog box.
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To DELETE A WINDOWS NT USER ACCOUNT

1. From the Setup menu, choose Security. The Security dialog box appears.
2. Click the NT Users tab.

3. Inthe User List box, select a Windows NT User.

4. Click Remove to remove the Windows NT User account.

Note: Clicking Remove does not delete the Windows user or group from the
network database. It only removes the Windows NT User account from your
list of Timbuktu Pro authorized users.

5. Click OK to save and close the Security dialog box.

ATTENDED ACCESS

For security reasons, you may not wish to assign some privileges to remote users.
When these users require one-time-only access to a certain service, they may con-
nect to your computer as Ask for Permission Users or as temporary guests.

ASK FOR PERMISSION ACCESS

If a Guest User is asking for permission to use a service you have not granted to
guests, the Ask for Permission dialog box will appear on your screen. The same
dialog box will appear if you have enabled the Ask for Host Permission option for
a specific Registered User or Windows NT User. (See “Defining Registered Users”
on page 74 and “Defining Windows NT Users” on page 78.)

Ask For Permission

The following user iz waiting for admittance:
Echo

IP: 123.476.44.27 Cancel

Service: Exchange Help |

WARMIMG! You are about to let another uzer access pour computer
via the abowve mentioned service.

Cloge any windows that contain confidential information before
allowing Contral or Observe.

Exchange will allow the remote uger to access the files on your
hard disk, as well az filez on any network drives pou are currently
logged into.
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The Ask for Permission dialog box provides the name of the computer requesting
the connection and the service that the remote user wishes to use. Click OK to ac-
cept the connection, or click Cancel to deny the remote user’s request.

Note: If you grant Ask for Permission access to a user requesting the Exchange
service, you automatically grant the user access to all Exchange subservices:
Exchange (Read), Exchange (Write) and Exchange (Delete).

ENABLING ASK FOR PERMISSION REQUESTS

If you enable Guests May Ask for Permission to Use Unchecked Services on the
Guests tab in the Security dialog box (see “Assigning Services to Guest Users” on
page 73), remote users can ask for permission to use services that have not been
assigned to Guest Users.

If a remote computer attempts to access a service that has not been assigned to
guests, a Log In dialog box will appear on the screen, asking whether the user
would like to connect as a Registered User (by supplying a name and password)
or as an Ask for Permission user. If the user chooses Ask for Permission, you (the
host) are prompted to approve the connection before the remote user can con-
nect.

Note: You cannot require users to ask for permission to use the Notify service.

To ENABLE REQUESTS BY ASK FOR PERMISSION USERS

1. From the Setup menu, choose Security. The Security dialog box appears.

2. Click the Guests tab. If the service for which you wish to require Ask For Per-
mission access is selected in this tab, deselect it.

3. Ensure the Guests May Ask for Permission to Use Unchecked Services check-
box is selected.

4. Click OK to save your changes and close the Security dialog box.

DISABLING ASK FOR PERMISSION ACCESS

If you decide that a certain service—for example, Control or Exchange—should not
be available to any user at any time, you must remove that service from the list of
guest privileges and from the list of privileges for every user account. You may
also disable the Ask for Permission feature.
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To REMOVE A SERVICE FROM ASK FOR PERMISSION ACCESS

From the Setup menu, choose Security. The Security dialog box appears.

Click the Guests tab. If the service you want to remove from access is
selected, deselect it. To prevent users from even asking for permission to use
the service, deselect Guests May Ask for Permission to Use Unchecked Ser-
vices. Keep in mind that deselecting the Ask for Permission option may lock
out services you want to keep available for Ask for Permission Users.

Click OK to save your changes and close the Security dialog box.

TEMPORARY GUEST ACCESS

The Admit Temporary Guest option allows you to grant temporary access to Tim-
buktu Pro users are who running older versions of Timbuktu Pro. Temporary
guests are similar to Ask for Permission Users, but older versions of Timbuktu Pro
are unable to request access. You must arrange the connection in advance.

To ADMIT A TEMPORARY GUEST

1.

Arrange an appointment with the user that wants to connect to your com-
puter.

At the appointed time, click the Connections menu and choose Admit Tempo-
rary Guest. The Admit Temporary Guest dialog box appears.

Admit Temporary Guest

The following guest iz waiting for admittance:
Echo

IP: 123.176.44.27 Cancel |
Service: Observe

Temporary Guest Privileges

¥ Send [" Exchange [Read)
[v Coniral [T Exchange [write)
[V Observe [" Exchange [Delete]
™ Chat ™ Intercom

My TCP/IP Address: |123.1?E.44.28

WARNING! You are about ko let another user access your computer
wia services checked in the box above.

Cloze any windows that contain confidential information before
allawing Contral or Dbzerve.

If Exchange is checked, the remote user will be able to access the
files on your hard dizk, az well as files on any network. drives you
are currently logged into.
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Select the services you wish to grant the temporary guest.

When the temporary guest connects to your PC, the guest computer’s Tim-
buktu name and network address are displayed under The Following Guest is
Waiting for Admittance, along with the access privilege the temporary guest
has requested.

5. Click OKto begin the attended access session.

6. You can always deny a session if the unexpected occurs. For example, if a
guest connects with a privilege you are not expecting—if the Control service
is requested instead of Observe—click Cancel to break the connection.

MONITORING REMOTE CONNECTIONS

There are a number of ways to keep track of and control Timbuktu Pro connections
to your computer. When a remote computer connects, the Timbuktu Pro icon in
the system tray on the taskbar alternates between the application icon and a ser-
vice icon that indicates the service being used. (For a list of icons, see “Icon Leg-
end” on page 94.) Right-click the Timbuktu Pro icon to display a list of current
users and the services they are using. You can disconnect any or all users at any
time.

In addition, the activity log tracks past connections, so you can check on previous
users at any time.

DISCONNECTING ALL REMOTE USERS

If you wish to disconnect all remote users from your computer (for example, you
wish to shut down Timbuktu Pro), click the Connections menu and choose Discon-
nect All Users. Timbuktu Pro immediately terminates sessions with all the remote
users listed below this command.

DISCONNECTING A SPECIFIC REMOTE USER

If you wish to disconnect a specific remote user from your computer (for example,
the useris using a service you did not intend to grant), click the Connections
menu and choose the remote user from the remote user list below the Disconnect
All Users option. Timbuktu Pro immediately terminates the session with the se-
lected remote user.
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KEEPING REMOTE USERS OuUT

You can prevent remote users from accessing your computer by removing all Reg-
istered User and Windows NT User accounts and removing all services from Guest
User access. More simply, you can exit and shut down Timbuktu Pro by clicking
the File menu and choosing Exit and Shut Down Timbuktu Pro. If you exit Timbuktu
Pro without shutting down the application (by clicking the File menu and choos-
ing Exit) remote users will still be able to use Timbuktu Pro to connect to your
computer.

CLEARING THE PREVIOUS USER LIST

The Previous User list consists of names of recent users who are no longer con-
nected to your computer. Those names appear on the Connections menu under
the Clear Previous User Log option, as well as in the system menu (right-click the
Timbuktu Pro icon in the system tray on the taskbar). You can remove names from
the Previous User list by choosing Clear Previous User Log from the Connections
menu or Clear Previous User List from the system menu.

Open Connections
P — Adr_mF Temporary Guest... Ctrl+G
Activity Log...

& Disconnect Echo

Clear Previous User List Disconnect All Users

£1Daydream 42 Disconnect Echa
£ baydream Clear Previous User Log
Admit Termpaorary Guest... & Echo
About Timbuktu Pro... &1 Daydream
N Daydream

Ezit and Shut Down Timbuktu Pro

Timbuktu Pro Scanner

Timbuktu Pro system menu -
Connections menu

The names that are listed below the Clear Previous User Log option are deleted.

THE ACTIVITY LoG

The activity log maintains a list of the all incoming and outgoing Timbuktu Pro
connections on your computer. The activity log is a useful record of Timbuktu Pro
activities. You can also use the activity log to diagnose problems you encounter
when using Timbuktu Pro.
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Each line of the activity log contains a date, a time, and the activity that was car-
ried out—for example, the Timbuktu Pro application was launched. The activity
log also contains the Timbuktu Pro computer name and IP address of each remote
user that connects to your computer. For incoming connections, it records when
the user connected or attempted to connect, and specifies which services the
user accessed.

For file transfers using the Send and Exchange services, the file name and the lo-
cal directory involved in the transfer are logged on both computers. For Exchange
file transfers, the guest computer also logs the remote directory. Finally, the activ-
ity log reports when Timbuktu Pro was loaded, when previous users were cleared
from the Connections menu, and when Timbuktu Pro was shut down.

At times you may wish to save the activity log for your records.

To VIEW AND SAVE THE ACTIVITY LOG

1. From the Connections menu, choose Activity Log. The Activity Log appears.

== Activity Log

2/11/00 4:18:50 PM
2/11/00 4:13:03 PM
2/11/00 4:159:04 PM
2/11/00 4:20:06 P
2/11/00 4:20:33 PM
2/11/00 4:20:54 P
2/11/00 4:20:56 PM
2/11/00 4:2211 PM
2/11/00 4:2217 PM
2/11/00 4:24:001 PM
2/11/00 4:24:02 P

|

Help

Host Motify End - SATURM SATURM 128121.60

Host Send Begn  SATURM SATURN 128.121.60
Host Send End  SATURM SATURM 128.121.80

Host Exchange Begin  PLUTO PLUTO 128121.8
Dial Direct Dialing 1(510) 440-2160

Dial Direct Disconnected

Host Control Begin  WEMUS VENLUS 12812160

Host Chat Beain  MARS MARS 128121.20

Host Chat End  MARS MARS 128.12.1.20

Host Exchange End  PLUTOD PLUTO 1281218

Host Control End - WENUS VENLUS 12812160

Save Az.. |

|

2. Ifyou’d like to save a copy of the activity log, verify that your computer has at
least 32K of available disk space, then click Save As.

3. Inthe Save As dialog box, enter a name for the saved activity log, and select
a destination folder. The activity log is saved in .txt format.

In addition to saving a copy of the activity log, you may edit or print it at any time.

To EDIT OR PRINT THE ACTIVITY LOG

1. To edit or print the activity log, click Save As in the Activity Log window and
save the log as a text document. The text document can then be opened and
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printed by a word processing application such as Notepad, or imported into
a spreadsheet or database document.

2. Click OK.

The activity log can preserve up to 32K of activity information before it begins to
discard its oldest records.

THE WINDOWS NT EVENT LoG

On Windows NT-based computers, Timbuktu Pro logs guest and host service
events to the Application Event Log.

To see these events in the Application Event Log, open the Windows Start menu.
Choose Programs » Administrative Tools » Event Viewer. From the Event Viewer’s
Log menu, choose Application.

Whether you use the Application Event Log or not, the standard Timbuktu Pro ac-
tivity log is still created.

USING A MASTER PASSWORD

In many situations it may be possible for multiple users to access your computer
directly by sitting at your workstation. To protect your Timbuktu Pro settings, you
can set a master password on the Master Password tab in the Preferences dialog
box. Your master password prevents unauthorized users from accessing any of
the options on the Setup menu, which is used to change Timbuktu Pro’s configu-
ration and security settings. When you use a master password, Timbuktu Pro will
not allow you to access the Security, Preferences, and LDAP Options dialog boxes
until you enter the correct password.

No one can bypass the master password. If you forget your master password, you
will need to re-install Timbuktu Pro.

See “Setting Up Your Master Password” on page 32 for details on how to set and
change your master password.
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CHAPTER 7: TIMBUKTU PRO USER ASSISTANCE

Timbuktu Pro was designed to be as intuitive and easy-to-use as possible. This
manual should answer most of your questions. If you’re still having difficulty, you
can refer to the online Help for more comprehensive information. If you are still
unable to solve your problem after referring to all the documentation, you may
contact Netopia’s Technical Support.

GETTING HELP IN TIMBUKTU PRO

Timbuktu Pro’s comprehensive online Help provides a variety of ways to answer
your questions. It contains step-by-step instructions for all common procedures,
as well as troubleshooting hints, keyboard shortcuts, and a glossary.

You can navigate through the online Help using the Table of Contents, Index, and
hyperlinks between Help topics.

You may also wish to view the Timbuktu Pro Release Notes, which may contain
feature and troubleshooting information that was not available at the time this
document was created.

OPENING TIMBUKTU PRO’S ONLINE HELP

In the main Timbuktu Pro window, click the Help menu and choose Contents. Or
press F1 from anywhere within Timbuktu Pro for context-sensitive Help. If a Help
button is available in a window or dialog box, click it to display the online Help
topic associated with that area of the user interface.

/89
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CONTACTING NETOPIA

If you require technical support, please browse Netopia’s Technical Notes and
Frequently Asked Questions, available 24 hours a day on our Web site at
http://www.netopia.com/support/.

Most common questions and problems are addressed there.

If you are unable to resolve your issue using our online technical support, please
use our online email form to send us a message. The form is at http://www.neto-
pia.com/support/contact_us.html.

Please provide the following information (for both the host and guest computers)
to assist us:

e Timbuktu Pro version and build number. Find this by selecting About Tim-
buktu Pro from the Help menu.

e Windows version, and any Service Packs installed.
e Error message or symptom.
e Steps to reproduce the error.
e Relevant system information:
. PC manufacturer and model
o CPU speed
o Amount of RAM installed
. Video card manufacturer and model
° Video device driver version
° Sound card manufacturer and model
o Modem manufacturer and connection speed (if relevant)
. Type of connection: DSL, cable, ISDN, modem, etc.

Netopia’s web site is at http://www.netopia.com/.

When you are prepared, contact Netopia Customer Service on the Web, or by mail
or fax.

Online Technical Support

Technical notes and Frequently Asked Questions which answer the most com-
monly asked questions and offer solutions for many common problems are avail-
able 24 hours a day on our Company Web site at

http://www.netopia.com/support/
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Mail

Netopia, Inc.

Customer Service

Marketplace Tower

6001 Shellmound Street, 4th Floor
Emeryville, CA 94608

USA

Fax

(510) 420-7609

OUTSIDE OF THE UNITED STATES AND CANADA

If you are not located in the United States or Canada, you can get service locally
by contacting your nearest Netopia reseller or distributor. For a worldwide list of
our distributors, see our Internet information resources at
http://www.netopia.com/partners/.
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APPENDIX A: KEYBOARD SHORTCUTS AND SERVICE
ICONS

Timbuktu Pro has a number of keyboard shortcuts that allow you to quickly ac-
cess connection tabs, menu options, and dialog box options without using your
mouse.

TIMBUKTU PRO KEYBOARD SHORTCUTS

Controlling a Macintosh computer is usually identical to controlling a Windows
computer. However, their keyboards are slightly different. The following table
shows how keys are mapped across platforms.

Note: If you type a keyboard shortcut while you are controlling a remote computer
and the Control window is active, the shortcut is carried out on the remote com-

puter only.
Windows Keys Macintosh Keys
ALT Option
CTRL Control
CTRL+ALT+DEL Control+Option+Delete
Right-click (on mouse) 3 (Command)
Window (Windows NT-based systems | & (Command)
only)

When you control a Macintosh, the Map Ctrl-> Cmd option appears on the system
menu in the screen-sharing window. (To open the system menu, click the Control
or Observe icon in the upper-left corner of the screen-sharing window.) If you en-
able this option, pressing CTRL on your Windows keyboard will send the equiva-

lent of a Command keystroke to the Macintosh.
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ICON LEGEND

2 10,15 4M

Timbuktu Pro’s service icons allow you to quickly identify its many services.

The Timbuktu Pro icon is displayed in the system tray on the Windows taskbar
whenever Timbuktu Pro is running. When a remote user connects to your com-
puter, the standard Timbuktu Pro icon alternates with a service icon indicating the
service in use. If the service icon is in color, a remote user is connected. If the ser-

vice icon is gray, the connection is closed.

Timbuktu Pro Icons

User Icon Meaning
@ A remote user is using the Send service with your computer.
'S..D A remote user is using the Exchange service with your com-
= puter.

A remote user is using the Observe service with your com-
puter.

A remote user is using the Control service with your com-
puter.

A remote user is using the Chat service with your computer.

A remote user is using the Intercom service with your com-
puter.

A remote user is using the Notify service with your computer.

A remote user is using the Invite service with your computer.




INDEX

A

accelerating performance 26
accepting incoming calls 33
activity log 14, 85
Activity Log option 86
Activity Log window 86
Add Files to Send dialog box 56
Add Users and Groups dialog box 79
adding files to FlashNotes 57
adding Windows NT Users 78
address books 15, 48, 49
Address Books connection tab 14, 47
Address Books tab 47
addresses
changing properties 49
saving to address books 48
Admit Temporary Guest dialog box 83
Admit Temporary Guest option 83
admitting temporary guests 81
Answer Automatically option (Notify Preferences)
65
Ask for Permission access
Log In dialog box 44
removing 82
requesting 44
Ask for Permission dialog box 81
Ask for Permission Users 71, 72, 81
allowing requests 74
asking for permission 44
granting access 82
granting services 82

Log In dialog box 44

requesting access 82
asking for permission 44

Log In dialog box 44
attended access 81
authenticating

Registered Users 74

Windows NT Users 78
AutoScroll feature 59
autoscrolling 26

B
blanking the screen. See secure screen blanking

C

Capture Frame 27, 60, 61
enabling 27
starting session 62
using 61

changing
address book properties 49
Dial Direct preferences 33
general preferences 23
master password preferences 32
master passwords 32
Notify preferences 31
Observe/Control preferences 25
Registered User accounts 77, 80
Send preferences 29

Chat service 66
printing and saving transcripts 66
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Chat window 66
chatting with remote users 66
checking for remote users 84
checking the activity log 85
Clear Previous User Log option 85
clearing the user list 85
compatibility between versions of Timbuktu Pro
15
computer name 24
connecting to remote computers 41to 53
Dial Direct connections 5o
Connection Documents 52
changing properties 53
creating 52
connection tabs
Address Books tab 14, 47
Dial Direct tab 5o, 51
LDAP tab 44
Recent Connections tab 14, 47, 48, 50
TCP/IP tab 43, 48
connections
making 41
re-establishing 47
to a previously-used computer 47
using Dial Direct 5o
using LDAP 44
using TCP/IP 43
using the Desktop Shortcut extension menu
52
Connections menu
Activity Log option 86
Admit Temporary Guest option 83
clearing users 8s
disconnecting remote users 84
Control service 59
Capture Frame 27, 61
changing preferences 25
controlling access to your computer 36
controlling remote computers 59
screen-sharing window 60
Copy dialog box 50

Copy to Address Book button 48
copying files 58
Create New Folder button 58
Create Shortcut on Desktop option 49
creating
desktop shortcuts 49
folders on remote computers 58
new address books 50
CTRL+ALT+DEL, sending to remote computers 63

D

default installation location 19
default service 48
defined 14
Desktop Shortcut extension menu 52
desktop shortcuts, creating 49
desktop wallpaper, hiding and displaying 26
Dial Direct connection tab 50, 51
enabling 5o
Dial Direct feature 13, 50
accepting incoming calls 33
changing preferences 33
establishing connections 51
Dial Direct tab (main Timbuktu Pro window) 5o,
51
enabling 50
Dial Direct tab (Preferences dialog box) 33
dialog boxes. See individual dialog box names
disconnecting remote users 84
all users 84
disk space
protecting from usage 30
required for installation 15
displaying
the desktop wallpaper 26
the Logon Information dialog box 63
DOS sessions, full-screen 61

E

enabling connection tabs
Dial Direct tab 5o
LDAP tab 44



Exchange service 58
creating new folders 58
subservices 82
Exchange window 58
exchanging files 58
Exit and Shut Down Timbuktu Pro option 22
Exit option 22
exiting and shutting down Timbuktu Pro 22
exiting Timbuktu Pro 22

F

file extensions
.tbk 49
.tmb 53
File menu
Exit and Shut Down Timbuktu Pro option 22
Exit option 22
Open Address Book option 49
files
adding to FlashNotes 56
copying between computers 58
saving from FlashNotes 57
sending 55
sending to another computer 57
files received folder 30, 55
FlashNote window 55
FlashNotes 55
adding files 56, 57
display options 30
files received folder 30, 55
printing 57
saving 57
sending 55
folders
creating on remote computers 58
See also files

G

general preferences, changing 23
General tab (Preferences dialog box) 23
getting Help 89

granting services to Guest Users 73
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Guest Users 71
defined 71
granting services to 73
guests
disconnecting 84
monitoring 84
temporary 83
Guests May Ask for Permission to Use Unchecked
Services option 82, 83
Guests tab (Security dialog box) 73

H

hardware requirements 15
Help 89

icons 94
identifying your computer to remote users 24
ignoring Notify requests 65
incoming calls, accepting 33
installation
default location 19
hardware requirements 15
pre-requisites 17
Select Destination Directory dialog box 19
Intercom service 67
Intercom window 67
Internet Locator 13, 24, 43
Invite service 68
Invite window 68

K

keeping remote users out 85
keyboard shortcuts 93

L

launching Timbuktu Pro as a service 24
LDAP connection tab 13, 45
enabling 44
LDAP option (Setup menu) 36
LDAP Options dialog box 35
Advanced tab 35
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LDAP Options dialog box (continued)
General tab 35
User’s Profile tab 36
LDAP server
finding remote computers 44
setting your options 35
user profile 36
LDAP tab (main Timbuktu Pro window) 13, 44, 45
enabling 44
location
default installation folder 19
files received folder 30, 55
Log In dialog box 44
logging on to a Windows 2000 computer 63
logging on to a Windows NT computer 63
Logon Information dialog box, displaying 63

M

main Timbuktu Pro window 15, 39
Address Books tab 47
Dial Direct tab 51
enabling Dial Direct tab 50
enabling LDAP tab 44
LDAP tab 45
Recent Connections tab 47, 48, 50
TCP/IPtab 48
making a Timbuktu Pro connection 41to 53
making connections 41
Master Password tab (Preferences dialog box)
32,33
master passwords
changing 32
changing preferences 32
removing 33
setting 32
using 87
modem connections
changing preferences 33
Dial Direct connections 5o
modifying. See changing
moving files between computers 58

N

Network Neighborhood integration 14
New Address Book dialog box 50
new features in Timbuktu Pro 10
Notify service 64
acknowledging requests 65
answering automatically 65
changing preferences 31
ignoring requests 65
setting message to be displayed 32
Notify tab (Preferences dialog box) 31
Notify window 64
NT Users tab 78
failure to appear 78

0]

Observe service 59
Capture Frame 27, 61
changing preferences 25
Observe/Control tab (Preferences dialog box) 25
observing remote computers 59, 60
online Help 89
Open Address Book option 49
Open File dialog box 49
opening address books 49

P

password restrictions 76
Password Restrictions dialog box 76
Password Restrictions option 76
performance

accelerating 26

protecting disk space 30

turning off desktop wallpaper 26
Preferences dialog box 23

Dial Direct tab 33

General tab 23

Master Password tab 32, 33

Notify tab 31

Observe/Control tab 25

Send tab 29, 30



Preferences option 23
preventing unauthorized access 87
previous users
activity log 85
clearing 85
printing
Chat sessions 66
FlashNotes 57
the activity log 86
protecting disk space 30

R

Recent Connections connection tab 14, 47, 48,
50
Recent Connections tab (main Timbuktu Pro
window) 14
Registered Users 71, 74
authenticating 74
changing 77
defined 72
Log In dialog box 44
Registered Users tab (Security dialog box) 74
remote computers
accessing through the Network
Neighborhood 14
connecting to 41to 53
finding with LDAP 44
re-establishing a connection 47
remote connections, monitoring 84
Remote Control 59
remote users
checking for 84
controlling access 85
disconnecting 84
removing
master passwords 33
remote users 84

requesting access as an Ask for Permission User

44, 82
requesting notification 64

Index

requesting permission 44, 82
Log In dialog box 44
requests for permission
allowing 74, 82
granting 82
preventing 82
requirements
compatibility 15
hardware 15
software 15
restricting access to your computer 36

S

saving chat sessions 66

saving files
files received folder 30
from FlashNotes 57

saving FlashNotes 57

screen blanking, secure. See secure screen
blanking

screen-sharing window 60
accelerating performance 26
Capture Frame 27, 61
closing 60
scrolling automatically 26
system menu 61
troubleshooting 60

searching for remote computers 44

secure screen blanking 26 to 29

security 71
adding Windows NT Users 78
Capture Frame 27, 61
checking for remote users 84
controlling access to your computer 36
disconnecting remote users 84
granting services to Guest Users 73
keeping remote users out 8g
master passwords 32, 33, 87
password restrictions 76
Registered Users 74
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Security dialog box

Guests tab 73

NT Users tab 78, 80, 81

Registered Users tab 74
Select Destination Directory dialog box 19
Send service 55

changing preferences 29

files received folder 55

FlashNote display options 30

printing FlashNotes 57

saving FlashNotes 57
Send tab (Preferences dialog box) 30
sending files to another computer 57
sending messages and files 55
services

Chat 66

Control 59

Exchange 58, 82

Intercom 67

Invite 68

Notify 64

Observe 59

Send 55

setting Notify messages 32
setting password restrictions 76
setting up Timbuktu Pro 21
Setup menu

LDAP option 36

Preferences option 23

Security option 73, 74, 80, 81
shortcut menu 13
shortcuts, keyboard 93
shutting down Timbuktu Pro 22
software requirements 15
speaking to remote users 67
Start Timbuktu Pro as a Service option

(Preferences dialog box) 24
starting Timbuktu Pro 21
startup, launching Timbuktu Pro as a service 24
system menu 61, 85

T

tabs. See connection tabs
.tbk file extension 49
TCP/IP address 40
TCP/IP connection tab 13, 43, 48
making a new connection 43
TCP/IP tab 43
TCP/IP tab (main Timbuktu Pro window) 13, 48
making a new connection 43
temporary guests 71, 83
admitting 81, 83
Timbuktu computer name 24
Timbuktu Pro
exiting 22
features 10
activity log 14, 85
address books 15, 47
comprehensive multi-level security 14,
71
cross-platform connections 15
My Network Places integration 14
Network Neighborhood integration 14
Remote Control 11, 59
secure screen blanking 27
sending messages 14
service shortcuts 14, 52
installing 17
introduction 7
keyboard shortcuts 93
launching as a service 24
main window 39
new features 10
security 71
setting up 21
shutting down 22
startup 21
types of users 71
uninstalling 20



Timbuktu Pro Connection Documents 14, 52

changing properties 53
creating 52
Timbuktu Pro icons 94
Timbuktu Pro window 15, 39
Address Books tab 47
Dial Direct tab 51
enabling Dial Direct tab 50
enabling LDAP tab 44
LDAP tab 45
Recent Connections tab 47, 48, 50
TCP/IP tab 48
Timbuktu Pro, new features 10
.tmb file extension 53
transcripts of Chat sessions 66

U

uninstalling Timbuktu Pro 20
Use Accelerated Remote Control option
(Preferences dialog box) 26

User’s Profile tab (LDAP Options dialog box) 36

using the address books 48

w

windows
Activity Log window 86
Chat window 66
Exchange window 58
FlashNote window 55
Intercom window 67
Invite window 68
main Timbuktu Pro window 15
Notify window 64
screen-sharing 6o

Windows 2000 Users. See Windows NT Users

Windows NT Event Log 87

Index

Windows NT Users 71, 72
adding 78
authenticating 78
changing 8o
defined 72
defining 78

Windows NT/Windows 2000
logging on 63
sending CTRL+ALT+DEL 63
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Windows NT/Windows 2000 Logon Information

dialog box, displaying 63
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